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Abstract 

Heavy ion radiotherapy offers high dose conformity in the tumor volume while sparing healthy 
tissue. Because of the inverse dose profile, the maximal dose is deposited in a well-defined, 
narrow depth range at the distal track end. In order to fully benefit from this sharp dose fall-off, 
precise knowledge of ion ranges in the patient is substantial. Uncertainties in imaging, in the 
treatment planning process and in the composition of resulting particle fields due to 
fragmentation call for reliable in-vivo verification. 
Biocompatible fluorescent nuclear track detectors (FNTDs) are promising candidates for high-
accuracy in-vivo range measurements and have, therefore, been investigated in this bachelor 
thesis. Their superior spatial resolution allows for measuring single particle tracks. 
Irradiation with protons as well as with carbon, sulfur and magnesium ions at the Max Planck 
Institute for Nuclear Physics has shown that FNTDs enable the possibility of high-accuracy ion 
range measurements. Single particle track ranges have been determined with less than 3% 
deviation from tabulated SRIM values. An automatic track bulk evaluation routine was 
established for particle fluences greater than 10଻ cmିଶ yielding the same level of precision. 
In a second series of experiments, the basic suitability of FNTDs for clinical in-vivo applications 
has been analyzed. A treatment plan for a PMMA cylinder containing tissue surrogates and 
detectors was created and applied at the Heidelberg Ion-Beam Therapy Center. The planned 
distal edge was compared to the monitored fluorescence profile after proton irradiation. 
Differences in planned and observed range lay well below the accuracy limiting 1 mm CT slice 
thickness. 

 

Zusammenfassung 

Die Strahlentherapie mit Schwerionen bietet eine sehr gute Abdeckung des Tumorvolumens bei 
gleichzeitiger Schonung gesunden Gewebes. Durch das inverse Dosisprofil der Teilchen wird die 
maximale Dosis in einem scharf begrenzten Tiefenbereich deponiert. Um von dieser distalen 
Dosiskante zu profitieren, ist allerdings die genaue Kenntnis von Reichweiten im Patienten 
unabdingbar. Unsicherheiten in der Bildgebung, im Planungsprozess und in der genauen 
Zusammensetzung der Teilchenfelder am Zielort aufgrund von Fragmentationsprozessen 
erzwingen eine verlässliche in-vivo Verifikation. 
Da biokompatible, fluoreszierende Kernspurdetektoren (FNTDs) genaue in-vivo Reichweiten-
messungen in Aussicht stellen, wurden sie in dieser Bachelorarbeit untersucht. Ihre hohe 
Ortsauflösung erlaubt den zuverlässigen Nachweis einzelner Kern- und Fragmentspuren. 
Die Bestrahlung mit Protonen sowie mit Kohlenstoff-, Magnesium- und Schwefelionen am Max-
Planck-Institut für Kernphysik hat gezeigt, dass sich FNTDs exzellent für Reichweitenmessungen 
eignen. Reichweiten einzelner Kernspuren wurden mit weniger als 3% Abweichung von 
tabellierten Werten (SRIM) ermittelt. Außerdem konnte eine Auswertungsroutine für Detektoren, 
die mit Fluenzen Ȱ > 10଻ cmିଶ bestrahlt wurden, ohne Genauigkeitsverlust automatisiert 
werden. 
In einer zweiten Reihe von Experimenten wurde darauf aufbauend analysiert, ob sich FNTDs 
grundsätzlich auch für in-vivo Reichweitenmessungen eignen. Am Heidelberger Ionenstrahl-
Therapiezentrum wurde für einen PMMA-Zylinder, der neben Gewebeersatzmaterialien auch 
Kernspurdetektoren enthielt, ein Bestrahlungsplan erstellt und appliziert. Die geplante distale 
Kante wurde nach der Protonenbestrahlung mit dem aufgezeichneten Fluoreszenzprofil im 
Detektor verglichen. Die Unterschiede zwischen geplanter und beobachteter Reichweite lagen 
weit unter der genauigkeitslimitierenden CT-Schichtdicke von 1 mm. 
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1 INTRODUCTION 
 

Radiation therapy with heavy charged particles (HCPs) such as protons and carbon 
ions has gained increasing interest over the past years. Its main assets are the 
inverse dose profile with a defined range yielding superior dose conformity and the 
high ionization density giving a differential biological effect between tumor and 
healthy tissue. However, incomplete tissue knowledge as well as uncertainties in 
patient imaging, in the treatment planning process and in resulting particle fields 
due to fragmentation can largely jeopardize the potential clinical benefit. 

Treatment plans for ion radiotherapy undergo quality assurance on numerous levels 
before being applied. Particle fluence and energy are optimized on planning 
computers to achieve the desired dose distribution in malignant tissue taking 
scattering cross-sections into account. The machine delivery itself is constantly 
being supervised. Currently, the final step is the verification of the forward 
calculated individual treatment plan in a water phantom, but there are still only 
limited means for in-vivo verifications (e.g. PET and prompt gamma). 

Novel fluorescent nuclear track detectors (FNTDs) based on biocompatible 
aluminum oxide crystals are promising candidates for in-vivo range and 
fragmentation monitoring. Their superior spatial resolution allows for measuring 
single particle tracks. At the same time, FNTDs might serve as x-ray markers 
because of their high density. In this thesis, the basic suitability of FNTDs for clinical 
in-vivo applications has, therefore, been investigated. 

In a first series of experiments, FNTDs have been irradiated with carbon, 
magnesium and sulfur ions at the Max Planck Institute for Nuclear Physics (section 
4.1) to compare previous successful single range measurements with new bulk 
evaluation techniques (section 5.1). The second experiment serves as a precursor of 
later in-vivo FNTD applications. The entire treatment planning process was applied 
to a PMMA cylinder with six different insert combinations – from CT scans over 
contouring and planning to the actual proton irradiation at the Heidelberg Ion-Beam 
Therapy Center (section 4.2). The predicted distal edge in the implanted detector 
can be verified via bulk range measurements (section 5.2). 

Fundamental quantities with relevance to the measurements conducted are 
introduced in chapter 2. Physical properties of AlଶOଷ: C, Mg crystals and used tissue 
surrogates as well as irradiation facilities and readout tools are described in chapter 
3. Experimental setups and the obtained results are given in chapter 4 and 5. 
Chapter 6 contains a final summary and discussion. 
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2 FUNDAMENTAL QUANTITIES 
 

The International Commission on Radiation Units and Measurements (ICRU) 
defined fundamental quantities for ionizing radiation in their 60th report (1998 
[11]). Those of importance for this thesis will be outlined in this chapter. 

 

2.1 Ionizing radiation 

The process of radiation refers to particles or waves transporting energy through a 
medium or space. If one or more electrons are liberated in collisions with atoms or 
molecules, one speaks of ionizing radiation. The likelihood of ionization decreases 
with decreasing particle velocity (energy). The principle aim of using ionizing 
radiation in therapy is to stop unregulated cell growth where chemotherapy or 
surgery cannot be applied. 

 

2.2 Particle fluence 

The particle fluence Ȱ at a point ݎറ in space is defined as the number dܰ of particles 
incident on a sphere of cross-sectional area dୄܣ: 

 Ȱ(ݎറ) ؔ dܰ
dୄܣ

 ൤ 1
cmଶ൨ 

 

(2.1) 
 

A sphere has been used in this definition to express that one considers an area dୄܣ 
perpendicular to the direction of each particle. If beam particles are unidirectional, 
on parallel, unaltered trajectories and homogeneously distributed within the beam, 
the expression for the fluence simplifies to the total number ܰ of particles 
penetrating a finite perpendicular area ୄܣ: 

 Ȱ =
ܰ
ୄܣ

 
 

(2.2) 
 

Equation 2.2 applies to most experimental setups of this thesis. The particle fluence 
Ȱ can simply be determined by measuring the total number of particles ܰ. 
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2.3 Absorbed dose 

Energy conservation for a single interaction ݅ in matter yields: 

 ߳௜ = ߳௜௡ െ ߳௢௨௧ + ܳ, (2.3) 
 

where ߳௜  is the deposited energy, ߳௜௡ is the kinetic energy of the incident ionizing 
particle, ߳௢௨௧ is the sum of the kinetic energies of all ionizing particles leaving the 
interaction and ܳ is the change in the rest energies of the nucleus and of all particles 
involved in the interaction. 

The total imparted energy ߳ to matter in a given volume of a single ionizing particle 
is the sum of all deposited energies ߳௜  due to multiple interactions: 

 ߳ = ෍߳௜
௜

 
 

(2.4) 
 

At clinical fluences millions of ionizing particles enter the target volume. The 
absorbed dose ܦ measures the mean energy imparted d߳ҧ to matter of mass d݉, thus 

ܦ  ؔ d߳ҧ
d݉  [Gy]. 

 

(2.5) 

 
One gray is defined as the absorption of one joule of ionizing radiation by one 
kilogram of matter: 

 1 Gy ؔ 1 
J

kg 
 

(2.6) 
 

FNTDs monitor electronic interactions since secondary electrons are being captured 
in color centers. The observed fluorescence signal, therefore, correlates to the sum 
of all deposited energies ߳. 

 

2.4 Linear stopping power 

When traversing a medium, particles will lose their kinetic energy and finally come 
to rest. The linear stopping power quantifies this process for charged particles in 
neutral materials. It is defined as the quotient of lost kinetic energy dܧ by the 
traversed distance d݈: 

 ܵ ؔ dܧ
d݈  ൤MeV

cm
൨ 

 

(2.7) 
 

Three major components contribute to the total linear stopping power ܵ depending 
on the interaction of incident particles with the matter penetrated: 



 
2.5     Linear energy transfer 
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x The linear electronic stopping power ܵ௘௟  considers inelastic collision with 
electrons. 

x The linear radiative stopping power ܵ௥௔ௗ  is due to emission of 
bremstrahlung in the electric field of atomic nuclei or atomic electrons and, 
therefore, only of relevant magnitude if electrons are the incident particles. 

x The linear nuclear stopping power ܵ௡௨௖  takes elastic Coulomb collisions with 
heavy nuclei into account. Recoil energy is imparted to target atoms. In 
addition, one can also consider energy losses due to inelastic nuclear 
processes. 

The linear stopping power can be written as a sum of all three terms: 

 ܵ = ܵ௘௟ + ܵ௥௔ௗ + ܵ௡௨௖  (2.8) 
 

The electronic component is of major significance for ion range measurements in 
this thesis because radiochromatic transformation in FNTDs is triggered by 
electronic rather than nuclear processes. 

 

2.5 Linear energy transfer 

In hadron therapy, one is interested in the ionization density along the particle 
trajectory. Secondary electrons or ߜ-electrons carry away kinetic energy from the 
regarded cell volume. The linear energy transfer (LET) has been introduced in 
search of a quantity that connects physical energy transfer with biological cell 
response more directly than dose. It is defined as the difference of the linear 
electronic stopping power ܵ௘௟  and the sum of the kinetic energies of all released 
electrons: 

 
LET௱ ؔ ܵ௘௟ െ

dܧ௱ఋ
d݈  ൤keV

Ɋm
൨ 

 

(2.9) 
 

The sum of the kinetic energies dܧ௱ఋ  has to be greater than a specific energy cutoff ߂. 
Secondary electrons with kinetic energies smaller than ߂ are still considered to be 
part of the HCP track core. The energy cutoff can, therefore, be regarded as a pipe 
around the particle track. Only energy transferred to secondary electrons leaving 
the pipe is subtracted from the linear electronic stopping power ܵ௘௟ . 

 

2.6 Projected range 

HCPs traversing matter continuously slow down due to momentum transfers. In 
order to calculate the projected range ܴ of an incident particle in a target material 
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one has to integrate the inverse linear stopping power ܵିଵ over all kinetic energies 
௠௔௫ܧ] in the interval ܧ  :[௠௜௡ܧ,

 ܴ ؔ න dܧ
ܵ

ா೘೔೙

ா೘ೌೣ
 [cm] 

 

(2.10) 

 

The upper limit of the integral cannot be zero since ܵ(0) = 0. Incident particles at 
rest will not impart energy. Therefore, a minimal cut-off energy ܧ௠௜௡ is introduced. 
Because very low particle energies only have minor contributions to the total 
projected range, equation 2.10 is a reasonable range definition. 

In this thesis, the calculation of inverse dose profiles is based on tabulated SRIM 
data (Stopping and Range of Ions in Matter, J.F. Ziegler, 2012 [22]) and the 
continuous slowing down approximation (CSDA) assuming that incident particles 
gradually impart their energy in small range intervals of width ȟܴ௡. As figure 2.1 
shows, incident particles enter the regarded voxel with a kinetic energy ܧ௡ and leave 
it with ܧ௡ାଵ < ௡ܧ . The linear stopping power is presumed constant and can be 
calculated as a mean of ܵ௡ and ܵ௡ାଵ, where ܵ௡ and ܵ௡ାଵ are the corresponding linear 
stopping powers to ܧ௡ and ܧ௡ାଵ. They can be obtained from SRIM tables. 

 

Figure 2.1  CSDA for particles traversing small volumes of width ȟܴ௡ 

For the calculation of the depth-dose curves, 1% energy loss per range interval was 
chosen meaning: 

௡ܧ  = 0.99௡ܧ଴ and (2.11) 
 

 ȟܴ௡ = 2
௡ܧ െ ௡ାଵܧ
ܵ௡ + ܵ௡ାଵ

 
 

(2.12) 
 

 ଴ is the initial kinetic energy of the particle beam. If one additionally assumesܧ
constant particle fluence Ȱ throughout the detector, the absorbed dose can be 
calculated in each volume via 

௡ܦ  =
ܵ௡ + ܵ௡ାଵ

ߩ2 Ȱ 
 

(2.13) 
 

 ௡ାଵܧ ௡ܧ

ܵ௡ + ܵ௡ାଵ
2  

ȟܴ௡ 
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 is the physical density of the target material. This iteration was applied until a ߩ
cutoff energy of 1 keV was reached. Figure 2.3 shows the resulting depth-dose curve 
of 100 MeV uΤ  carbon ions in polymethyl methacrylate (PMMA). 

 

Figure 2.2  SRIM calculated depth-dose curve of a 100 MeV/u carbon ion beam in PMMA 

The relative absorbed dose ܦ ௠௔௫Τܦ  is plotted against the traversed distance in the 
target. The projected range ܴ can also be defined as the depth in which the relative 
absorbed dose reaches the 80% threshold. This is visualized by the blue line. Monte 
Carlo calculations also consider straggling resulting in a broader Bragg peak. A 
FLUKA (A. Fassò, 2012 [6]) simulated depth-dose curve can be seen in figure 2.3. 

 

Figure 2.3  FLUKA simulated depth-dose curve of a 100 MeV/u carbon ion beam in PMMA 
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3 MATERIALS AND METHODS 
 

Fluorescent nuclear track detector (FNTD) technology is presented in this chapter. 
Detector properties and characteristics are discussed in section 3.1. Experiments 
involved irradiation at two different facilities (section 3.2). Irradiated detectors 
were read out with the confocal laser-scanning microscope described in section 3.3. 
CT scans of FNTDs and tissue surrogates (section 3.5) were done on the Siemens 
SOMATOM Sensation 4 (section 3.4). The evaluation of microscope and CT images 
used data processing techniques outlined in section 3.6. 

 

3.1 Fluorescent nuclear track detectors 

3.1.1 Introduction 

Novel fluorescent nuclear track detectors (FNTDs), recently developed and 
demonstrated by Landauer Inc., have originally been designed for high capacity 
volumetric optical data storage. Based on single aluminum oxide crystals doped with 
carbon and magnesium, FNTDs contain very high concentrations of aggregate 
oxygen vacancy defects which stimulate the production of new color centers during 
crystal growth. Because these color centers exhibit radiochromatic transformations 
under ionizing radiation, FNTDs show excellent detection efficiency of fast neutrons 
and swift heavy charged particles. For this study, samples from single AlଶOଷ: C, Mg 
crystals were cut along the optical ܿ-axis into small rectangular plates (4.0 × 6.0 ×
0.5 mmଷ) and polished on one of their large sides to obtain an optically transparent 
surface. 

 

Figure 3.1  Size of a FNTD compared to a one cent coin 
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3.1.2 Crystal structure and defect properties 

In ߙ-AlଶOଷ crystals (corundum) the Oଶି ions form a rigid, slightly distorted 
hexagonal-close-packed sublattice. Two out of every three octahedral interstices are 
occupied by an Alଷା ion. This means that each Oଶି ion is surrounded by four 
tetrahedral nearest-neighbor Alଷା ions and each Alଷା ion is surrounded by six Oଶି 
ions as shown in figure 3.2. ߙ-AlଶOଷ has a physical density of 3.98 g cmଷΤ . 

 

Figure 3.2  Crystal structure of corundum (ߙ-AlଶOଷ); reprinted from [3] 

Desired AlଶOଷ: C, Mg single crystals are grown from the melt in a highly reduced 
atmosphere at low partial pressure of oxygen using the Czochralski method (M.S. 
Akselrod, 2003 [2]): Aluminum oxide powder is melted in a crucible and dopant 
impurity atoms (C and Mg) are added. A precisely along the optical ܿ-axis oriented 
rod-mounted AlଶOଷ: C, Mg seed crystal is then dipped into the molten material, 
slowly pulled upwards and rotated simultaneously. The crystallization process at 
the seed surface is controlled by strong temperature gradients, the pulling rate and 
the speed of rotation. As a result, a large AlଶOଷ: C, Mg single crystal can be extracted. 

Being grown in a reduced atmosphere, this crystal will contain numerous aggregate 
oxygen vacancy defects throughout its lattice. The absence of an Oଶି ion leads to a 
strong local charge imbalance. Because two electrons can be trapped in such a 
vacancy, it is denoted as a Fଶା color center. The majority of these color centers 
contains one electron: 

 Fଶା(Mg) + eି ื Fା(Mg) (3.1) 
 

In order to charge-compensate the remaining imbalance Alଷା ions are substituted by 
Mgଶା ions yielding a net local charge of െ1. It is believed that two one-electron Fା 
color centers are always surrounded by two Mgଶା ions forming a two-electron 
Fଶଶା(2Mg) color center as depicted in figure 3.3 (G.M. Akselrod, 2006 [1]). 



 
3.1     Fluorescent nuclear track detetcors 

 

 

11 
 

 

Figure 3.3  Model of the Fଶଶା(2Mg) aggregate defect; reprinted from [3] 

The passage of a charged particle through the crystal lattice leads to ionization. 
Holes are created in the valance band and free electrons in the conduction band 
which are then trapped in color centers producing radiochromatic transformation: 

 Fଶଶା(2Mg) + eି ื Fଶା(2Mg) (3.2) 
 

Transformed Fଶା(2Mg) color centers have three excited states identified by their 
absorption bands centered at 4.8 eV (260 nm), 3.7 eV (335 nm) and 2.0 eV (620 
nm). They produce fluorescence at 750 nm under optical excitation with a high 
quantum yield and a short lifetime of ߬ = 75 ± 5 ns. Untransformed Fଶଶା(2Mg) color 
centers, on the other hand, absorb in the blue region (435 nm) and emit 520 nm 
photons giving the as-grown crystals their green-yellow coloration (G.J. Sykora, 
2010 [20]). This significant difference is emphasized in figure 3.4.  

 

Figure 3.4  Absorption and fluorescence of Fଶଶା(2Mg) and Fଶା(2Mg) color centers; 
reprinted from [2] 
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The broad variety of excitation and emission bands of AlଶOଷ: C, Mg crystals has been 
investigated by Sykora and Akselrod (2010 [20]). Their results are listed in table 
3.1. 

 

excitation 
wavelength 

 

 

emission 
wavelength 

 

crystal 
defect 

 
 

240 nm 
 

 

325 nm 
 

Fା(Mg) 
 

255 nm 
 

 

325 nm 
 

Fା(Mg) 
 

260 nm 
 

 

750 nm 
 

Fଶା(2Mg) 
 

300 nm 
 

 

500 nm 
 

Fଶ 
 

335 nm 
 

 

750 nm 
 

Fଶା(2Mg) 
 

350 nm 
 

 

385 nm 
 

Fଶା(Mg) 
 

435 nm 
 

 

510 nm 
 

Fଶଶା(2Mg) 
 

620 nm 
 

 

750 nm 
 

Fଶା(2Mg) 

 
Table 3.1  Excitation and emission bands of AlଶOଷ: C, Mg crystals 

 

3.1.3 Confocal microscopy based readout 

Color centers undergo radiochromatic transformation along incident particle tracks 
because of secondary electron capture. When stimulated with a red laser (620 nm), 
these radiation-induced tracks appear as bright fluorescent features on dark 
background. Therefore, the FNTD readout is based on laser-induced fluorescence 
(also known as photo-luminescence) and not optically stimulated luminescence. 
Because of superior spatial resolution, individual ion tracks can be imaged using a 
laser scanning confocal fluorescence microscope allowing non-destructive readout.  

The microscope laser causes the transformed color centers of one distinct layer to 
fluoresce. This signal is then detected with avalanche photo-diodes and amplified. 
The confocal pinhole acts as a spatial filter, blocking all fluorescence originating 
outside of the focal spot of the objective lens. Obtaining data from numerous layers 
allows reconstructing 3D images of single tracks through the detector volume. 
Because the actual diameter of the track penumbra is in the order of several Ɋm 
depending on the particle atomic number and its energy, randomly distributed 
tracks can be imaged without significant overlap at track densities of at least 
10଺ cmିଶ (G.M. Akselrod, 2006 [1]). 
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Short fluorescence lifetime allows for fast laser scanning and high-productivity 
imaging. FNTDs are also sensitive to charged particles with very low LET 
(approximately 0.1 keV ɊmΤ ) including secondary electrons. The track detection 
efficiency for protons and heavy ions lies at nearly 100% (G.M. Akselrod, 2006 [1]). 
After non-destructive and completely optical readout with no chemical etching or 
other detector preparation, fluorescent tracks can be erased from the FNTD by 
thermally annealing the detector material at approximately 680°C for 10 – 15 
minutes (M.S. Akselrod, 2006 [4]). 

 

3.1.4 Further advantages of FNTDs 

FNTDs are passive integrating detectors which do not require wires, electronics or 
batteries during irradiation. They are cut from single aluminum oxide crystals. AlଶOଷ 
is a wide gap insulator with ܧ௚ = 9.5 eV and, therefore, a highly stable and inert 
material also in harsh environments such as vacuum (G.M. Akselrod, 2006 [1]). 
Discussed electron trapping centers are deep, thermally stable up to 600°C and 
immune to unwanted electromagnetic interferences. The spatial imaging resolution 
and the ability to non-destructively obtain 3D depth-dose distributions are major 
superiorities over conventionally processed CR-39 plastic nuclear track detectors. 

Aluminum oxides biocompatibility opens new possibilities for quality assurance in 
radiotherapy and diagnostic imaging. Implanted detectors or detectors in body 
cavities can help accessing direct information on a radiation treatment such as ion 
fluences, energies or ranges using fully automated and sophisticated processing 
routines. Irradiations of FNTDs at the Heidelberg Ion Beam Therapy Center within 
this study serve as a precursor of later in-vivo FNTD applications. 

 

3.2 Irradiation facilities 

3.2.1 Max Planck Institute for Nuclear Physics (MPI-K) 

The MPI-K, one out of 80 institutes of the Max Planck Society, offers a large number 
of ion sources. The accelerator complex consists of a flexible system of five different 
particle accelerators. Therefore, almost every type of ion beam can be provided over 
a large fluence range, also at low energies (MPI-K, 2012 [13]). 

In the first series of experiments, FNTDs were irradiated with C-12, Mg-24 and S-32 
ions. The 12 MV Tandem van-de-Graaff Accelerator established total kinetic energies 
of 48, 98 and 100 MeV, respectively. 
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3.2.2 Heidelberg Ion-Beam Therapy Center (HIT) 

The HIT is the first hospital-based treatment facility at a clinic in Europe where 
patients can be treated with protons as well as with carbon ions. The particle beam 
is accelerated in a synchrotron and guided into one of the three treatment rooms by 
strong magnets. At HIT, a new radiation method known as the “intensity-controlled 
rasterscan technique” offers the highest level precision in the three-dimensional 
radiation of tumors. Pencil beams follow the tumor contour while cross sections of 
the tumor are divided into several beam positions. Beam spots have an 
approximately Gaussian-shaped lateral profile. Available energy ranges from 48 to 
221 MeV for protons and 89 to 430 MeV uΤ  for carbon ions correspond to a water 
range of 2 to 31 cm (Heidelberg University Hospital, 2012 [9]). 

 

3.3 Zeiss LSM 710 

In this study, the Zeiss LSM710 inverted design laser scanning microscope provided 
by the light microscopy facility at DKFZ was used together with the 2009 ZEN 
control software for FNTD readout. The principles of confocal microscopy and the 
characteristics of the LSM 710 (Zeiss, 2009 [5]) will be discussed in the following. 

 

3.3.1 Light path, filters and detectors 

Confocal microscopy enables optical sectioning of the specimen by using a detector 
pinhole. Excitation of color centers is stimulated with a 633 nm Helium-Neon laser 
line (5 mW) resulting in emission of 750 nm fluorescence. As shown in figure 3.5, 
the laser light passes a multi-band beam splitter (MBS488/561/633) before being 
focused on the specimen by an objective lens (40x / 1.4 Oil DIC II). Because of the 
finite pinhole diameter, true point illumination cannot be achieved. The light cone 
also stimulates fluorescence behind and in front of the focal plane yielding an 
effective slice thickness ߜ௭. Fluorescence light passes the objective lens and the 
beam splitter (dichroic mirror). A tube lens focuses the emitted light on the pinhole, 
a circular aperture obstructing light rays off focus. The pinhole diameter ݀, 
therefore, limits the axial detection volume. Three photomultipliers (PMTs) and two 
fiber-coupled avalanche photodiodes (APDs) count fluorescence intensity. APDs are 
necessary because PMTs have very low quantum efficiency in the red. Scanning 
mirrors attached to piezoelectric crystals enable lateral deflection of laser and 
fluorescence light. A motor driven microscope stage realizes full 3D imaging. 
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Figure 3.5  Schematic diagram of the Zeiss LSM 710 light path; reprinted from [5] 

 

3.3.2 Control parameters 

The ZEN software allows controlling the following parameter for read out: 

x The digital gain ݃ and the digital offset ȟ݃ change the gray scale on 
histogram representation within ZEN. Since they do not influence the actual 
APD counting, they were kept at optimal settings of ݃ = 0.20 and ȟ݃ = 0.00. 

x The vertical and horizontal field size ݈௫ and ݈௬ determine the lateral 
dimensions of the image at variable pixel resolutions. 

x The dwell time ߬ ranging from 1.27 to 177.32 Ɋs defines how long the laser 
illuminates one spot position. It, therefore, influence the total number of 
detected photons ܰ. 

x ܰ can also be accumulated over a certain number of rescans ܴ = 1 … 16. 
x The relative excitation laser power ݌ can be reduced in order to prevent 

APDs from shutting down. For protection reasons, the photon counting rate 
is limited to ߟ௠௔௫ = 4 MHz. 

x The pinhole diameter ݀ defines the slice thickness ߜ௭ of an image. 
x When acquiring numerous images in depth, the step size ȟݖ is another 

important parameter. 

Dwell time ߬, number of rescans ܴ and relative laser power ݌ have to be chosen 
according to scan time and desired noise signal ratios. During readout, FNTDs were 
always stored in glass bottom microwell dishes from MatTek Corp., Ashland, MA, 
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USA (Part No. P35G-1.5-20-C) to keep them free from immersion oil. All images 
were taken in 16 bit color depth preserving the maximal dynamic range of 
ܰ௠௔௫ = 65535 (S. Greilich, in prep. [8]). 

 

3.4 Siemens SOMATOM Sensation 4 CT Scanner 

CT scans of the PMMA cylinder were done at the Kopfklinik, Heidelberg University 
Hospital, on a Siemens SOMATOM Sensation 4 CT Scanner (Siemens, 2011 [18]). It 
offers rotation times as fast as 500 ms and can do 160 slices in 20 seconds 
breathhold with a reconstruction time of 1.5 slices per second. The syngo 
application platform is also used at HIT. All CT scans used the ion RT protocol 
“01_HIT_BPL_Schaedel_S4” to ensure standard imaging. The tube current was fixed 
to 264 mAs (H40s kernel) at a voltage of 120 kVp. A slice thickness if 1 mm was 
chosen in order to achieve the highest distal resolution offered. 

 

3.5 Tissue surrogates 

In the second series of experiments, FNTDs were placed in a polymethyl 
methacrylate (PMMA) cylinder (length ܮ = 44.8 cm, outer radius ܴ = 8.0 cm and 
inner radius ݎ = 14.2 mm) behind different insert rods. PMMA has a physical 
density of 1.18 g cmଷΤ . A sketch of the cylinder can be seen in figure 3.6. 

The insert rods were made of PMMA and tissue-equivalent materials. The tissue 
surrogates shown in figure 3.7 are part of the Tissue Characterization Phantom 467 
manufactured by Gammex Inc. (2012 [7]). They mimic the elemental compositions 
of real tissues and their cross sections for diagnostic photon radiation. The 
manufacturer provides a specification sheet with physical and electron densities 
(compared to water): 

 

Gammex 
insert 

 

 

relative electron 
density ߩ௘ ௘௪Τߩ  

 

physical density 
g] ߩ cmଷΤ ] 

 
 

Lung (LN-450) 
 

 

0.40 
 

0.45 
 

Adipose (AP6) 
 

 

0.90 
 

0.92 
 

Liver (LV1) 
 

 

1.07 
 

1.08 
 

Bone (CB2-30%) 
 

 

1.28 
 

1.34 

 
Table 3.2  Physical and electron densities of Gammex inserts; reprinted from [7] 
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Figure 3.6  Schematic diagram of the PMMA cylinder 

 

 

Figure 3.7  Gammex inserts: adipose, lung, cortical bone and liver 

 

3.6 Data processing and evaluation 

Microscope images were processed using ImageJ (version 1.46a), a public domain 
Java program developed by Wayne Rasband (2012 [17]). The plug-in "Stack profile 
Plot" by Pariksheet Nanda saves the intensity profile of all images in a stack to a .txt 
file (P. Nanda, 2012 [17]). For further analysis, these text files were imported to R, a 
free software program for statistical computation. The R versions used in this thesis 
were 2.14 and higher (R Core Team, 2012 [14]). Visualization of final data and the 
creation of plots were done with OriginPro 8.6G. 
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Obtained DICOM (Digital Imaging and Communications in Medicine) data were 
visualized with the open-source software MITK-3M3 (version 1.1) developed by the 
division of Medical and Biological Informatics at DKFZ and mint medical (2012 
[14]). 

All Monte Carlo simulations have been carried out on FLUKA (copyright INFN and 
CERN). FLUKA is a fully integrated particle physics Monte Carlo simulation package. 
Original authors are Alberto Fassò, Alfredo Ferrari, Johannes Rantf and Paolo Sala et 
al (2012 [6]). Discrete stopping power or range values were taken from J.F. Ziegler’s 
SRIM (Stopping and Range of Ions in Matter) software – version 2012.01 [22]. 
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4 EXPERIMENTS 
 

In order to measure projected ranges at low and clinical fluences, FNTDs have been 
irradiated at the Max Planck Institute for Nuclear Physics (MPI-K) with carbon, 
magnesium and sulfur ions. The experimental setup and the irradiation parameters 
are outlined in section 4.1. Section 4.2 describes the standard treatment procedure – 
from CT scans over contouring and planning to the actual proton irradiation at the 
Heidelberg Ion-Beam Therapy Center (HIT). 

 

4.1 High-accuracy ion range measurements 

4.1.1 Experimental setup 

FNTDs were placed on an aluminum holder as seen in figure 4.1. The holder was 
then suspended in a vacuum chamber facing the particle beam. FNTDs were, 
therefore, irradiated parallel to their large sides. 

 

Figure 4.1  FNTD being placed on position 8 

 

4.1.2 Particles and fluences 

The particle fluence was controlled over a Faraday cup that could be moved in and 
out of the ion beam (comp. figure 4.2). In order to keep the cup on a constant 
potential, electrons have to neutralize the charge ݖ of attracted cations. This cup 
current increases linearly with increasing particle fluence. The MPI-K states that a 
cup current of ݖ ή 100 pA equals 0.6 × 10ଽ ions per second. By changing the beam 
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widening through quadrupole magnets and the total irradiation time, the desired 
fluences could be achieved. Note that the ion beam has an area of 1 cmଶ because of 
quadratic apertures and was assumed to be homogenous at all times. The irradiation 
protocol is listed in table 4.1. 

 

Figure 4.2  Schematic diagram of the Faraday cup 

 

 

FNTD 
number 

 

 

particle 
(charge) 

 

total kinetic 
energy [MeV] 

 

cup current 
[pA] 

 

irradiation 
time  [s] 

expected 
particle flu-
ence [cmିଶ] 

 
 

gk1000 
 

 

C-12 (5+) 
 

48.0 
 

0.643 
 

1.00 
 

7.7 × 10ହ 
 

gk1001 
 

 

C-12 (5+) 
 

48.0 
 

166.7 
 

500 
 

1.0 × 10ଵଵ 
 

gk1002 
 

 

S-32 (9+) 
 

100 
 

0.500 
 

2.00 
 

6.7 × 10ହ 
 

gk1003 
 

 

C-12 (5+) 
 

48.0 
 

0.643 
 

4.00 
 

3.1 × 10଺ 
 

gk1004 
 

 

C-12 (5+) 
 

48.0 
 

0.643 
 

40.0 
 

3.1 × 10଻ 
 

gk1005 
 

 

C-12 (5+) 
 

48.0 
 

16.67 
 

5.00 
 

1.0 × 10଼ 
 

gk1006 
 

 

C-12 (5+) 
 

48.0 
 

16.67 
 

50.0 
 

1.0 × 10ଽ 
 

gk1007 
 

 

C-12 (5+) 
 

48.0 
 

16.67 
 

500 
 

1.0 × 10ଵ଴ 
 

gk1008 
 

 

S-32 (9+) 
 

100 
 

300.0 
 

500 
 

1.0 × 10ଵଵ 
 

gk1009 
 

 

Mg-24 (8+) 
 

96.0 
 

0.200 
 

3.00 
 

4.5 × 10ହ 
 

gk1010 
 

 

Mg-24 (8+) 
 

96.0 
 

266.7 
 

500 
 

1.0 × 10ଵଵ 

 
Table 4.1  MPI-K irradiation protocol 

 

 

Faraday cup (kept 
on constant potential) 

cup 
current I 

positively charged 
particle beam (z) 
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4.1.3 Image acquisition 

Irradiated detectors were read out with the Zeiss LSM 710 confocal microscope 
introduced in section 3.3. The dwell time ߬, the pixel matrix and the relative laser 
power ݌ were adjusted for each detector to achieve optimal imaging parameters. 
Detectors irradiated with low and high fluences have generally been distinguished 
in readout procedure. A detailed readout protocol and an overview of acquired 
images can be found in appendix B.1. 

x For fluences smaller than 10଻ cmିଶ, single particle tracks were well visible 
under the microscope. 34 images were taken in depth to ensure that track 
core centers lie in the focal plane. This will allow for precise range 
measurements (comp. section 5.1.1). An exemplary image of single tracks 
can be seen in figure 4.3. 

 

Figure 4.3  3.1 × 10଺ carbon ions per cmଶ with track cores on and off focus 
(1024 × 1024 pixels, 100.85 Ɋs dwell time and 100% relative laser intensity) 

x For fluences greater than 10଻ cmିଶ, single tracks could no longer be 
resolved. Therefore, a larger area of the detector edge was imaged in only 
one depth. This was done by combining several single images in a so called 
tile scan. The automated evaluation routine of these pictures is explained in 
section 5.1.2. 

In a second readout, the pinhole diameter was reduced to cut off fluorescent light 
originating outside of the focal plane. The influence of the pinhole diameter on the 
accuracy of range measurements is examined in section 5.1.3. 
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4.2 In-vivo range measurements 

4.2.1 Estimation of lateral scattering 

FNTDs were placed in a PMMA phantom to compare the planned dose distribution 
with the actual fluorescence profile in the detector. The treatment planning software 
allows creating a clinical target in front of the detector which will be irradiated 
homogeneously. Because aluminum oxide is a highly dense material compared to 
PMMA, particles will have a much shorter range in the detector. In order to estimate 
the range difference and the lateral scattering in and out of the detector material, a 
FLUKA simulation based on so called Monte Carlo calculations was set up. This 
simulation will help defining the position of the clinical target in front of the FNTDs 
so that the distal edge is well visible in the detector after irradiation. 

The circular area of a PMMA cylinder (length ܮ = 44.8 cm and radius ܴ = 8.0 cm) 
was irradiated with a rectangular 142 MeV uΤ  proton beam (ݔ߂ = ݕ߂ = 2 cm). 
Three FNTDs were placed at 12 cm depth so that their small side (4.0 × 0.5 mmଶ) 
was facing the proton beam. This is depicted in figure 4.4. 

 

Figure 4.4  Schematic diagram of the FNTD irradiation at HIT 

FNTD material was assigned as aluminum oxide and the phantom cylinder as pre-
defined PMMA. The energy threshold for secondary particles was set to 100 keV uΤ  
while the heavy ion transport protocol was used on a precision simulation. The two 
dimensional depth-dose distribution for 10ଽ primaries shows significant lateral 
scattering influence in the surrounding FNTDs (labeled with 1 and 3 in figure 4.5). 
The centered detector appears to have a homogeneous dose distribution. Two 
phantom FNTDs were, therefore, assumed to be sufficient to reduce scattering 
effects in the detector which will be read out under the confocal microscope (labeled 
with 2 in figure 4.5). 
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Figure 4.5  FLUKA simulated two dimensional depth-dose distribution 

 

4.2.2 CT scans of the PMMA phantom 

CT scans of six different insert combination listed in table 4.2 have been obtained 
with the Siemens SOMATOM Sensation 4 CT Scanner (Kopfklinik, Heidelberg 
University Hospital). The RT protocol and imaging parameters are mentioned in 
section 3.4. The PMMA phantom was positioned via laser crosses. Small grooves on 
the front, as well as on the top, bottom, left and right side allow for exact alignment. 
Cylinder feet were pushed back as far as possible in order to reduce artifacts during 
scanning. Additional BeekleyTM spots on the front and sides should ensure precise 
mapping before irradiating the phantom at HIT. 

Figure 4.6 shows the placement of FNTDs (left) and Gammex insert (right) in the 
PMMA cylinder. The FNTD holder has a width of 6 mm and can be seen behind the 
white cortical bone insert. An overview of all six CT images can be found in 
Appendix B.2. 

   

Figure 4.6  Three FNTDs in their PMMA holder (left) and combination of Gammex inserts (right) 
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FNTD 
number 

 

 
insert combination 

 
 

 
gk2002 

 

 
2.8 cm PMMA, FNTDs 

 
gk2003 

 

 
16.8 cm PMMA, FNTDs 

 
gk2004 

 

 

5.6 cm PMMA, 1.0 cm titanium, 
5.6 cm PMMA, FNTDs 

 
gk2005 

 

 

11.2 cm PMMA, 
5.6 cm LN-450 lung, FNTDs 

 
gk2006 

 

 

5.6 cm LN-450 lung, 
11.2 cm PMMA, FNTDs 

 
gk2007 

 

5.6 cm AP6 adipose, 
5.6 cm LV1 liver, 

5.6 cm CB2-30% bone, FNTDs 
 

Table 4.2  Insert combinations behind which a holder with three FNTDs is positioned 

 

4.2.3 Contouring and planning 

Obtained DICOM data were saved to one of the standard treatment planning 
computers at HIT and imported to the Siemens patient system. Contouring the 
geometry of the experimental setup is necessary because used tissue surrogates are 
not listed in the Hounsfield look-up table. Therefore, the standard transformation 
from CT Hounsfield units to water equivalence could not be applied. 

First of all, the PMMA cylinder was defined as the skin in which the dose distribution 
shall be calculated. Surrounding skins are always assigned “chordoma2” as 
biological material. After that, the inserts were marked as normal organs. Pre-
defined physical materials were used to characterize their properties under 
irradiation. Towards the end of the contouring routine, the clinical target volume 
(CTV) was defined. It had a lateral area of 5 × 5 cmଶ and a distal depth of 1 cm. The 
CTV was positioned at the center of the PMMA cylinder and had an overlap of 3 mm 
with the FNTDs which have not been contoured. In a final step, the laser origin and 
the target point were set up. They mark the center of the cylinder face and, 
therefore, the entrance point of the particle beam into the phantom. Note that a thin 
slice of air (2 mm) had to be contoured in front of the cylinder because particles can 
only enter air in the treatment planning software. Figure 4.7 shows the structure 
plan of gk2007. 
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Figure 4.7  Structure plan of gk2007: PMMA cylinder in light blue containing three Gammex inserts 
(adipose, liver, bone) and the red CTV; air slice in dark blue at the cylinder face 

Contouring and planning at HIT lead to the establishment of a workflow mentioning 
a detailed planning protocol, important parameters and useful hints. An excerpt can 
be found in appendix C.2. 

Based on a complete structure plan, a treatment plan can be created. The syngo.via 
software syncs with the HIT archive and can load desired patients onto the local 
database. A treatment plan requires the following input parameters: 

x The dose prescription defines the absorbed dose in the CTV and the number 
of treatment fractions. 

x Incident particles, irradiation direction, lateral and longitudinal beam spot 
density as well as treatment room and table position must be determined 
under beam setup. 

x The position verification menu enables x-ray positioning prior to irradiation. 
One can map CT scans with positioning images and apply automated 
alignment. 

x In a final step, optimization parameters have to be set up. The standard 
settings for proton irradiation are mentioned in appendix C.2. They cover 
dose constraints, beam weights and algorithm parameters. 

Once all parameters are defined, the optimization routine can be started. The 
computer now calculates particle energies and fluences to achieve a homogenous 
dose distribution in the CTV while sparing surrounding organs. This process can be 
repeated varying the following parameters: 
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x The range step influences general energy settings. For protons, a minimal 
value of 1.0 mm is available. The smaller the range step, the longer the total 
irradiation time. 

x Minimal and maximal dose are given for all fractions in total. The weighting 
ratio decides whether the absorbed dose shall be rather over or 
underestimated. 

x A third variable parameter is the virtual target expansion. It offers additional 
degrees of freedom to the optimization routine. A broad virtual target allows 
scan spots outside the CTV to achieve the desired dose distribution. In order 
to improve the distal edge, one can change the distal expansion from 2.0  
(standard value) to 1.0 mm. 

In an optimal depth-dose distribution, the 100% and the 10% iso-dose lines lie 
within the FNTD – one at the beginning and one at the end of the detector volume. 
This is depicted in figure 4.8. 

 

Figure 4.8  Optimized dose distribution in gk2003: The PMMA insert is contoured 
with the bold orange line and the CTV with the bold red line. 

The FNTDs appear white in the center of the image. 

Figure 4.8 also shows that each optimized treatment plan was finalized calculating 
the effective dose distribution in the surrounding skin. The effective dose is the 
product of the relative biological effectiveness (RBE) with the physical absorbed 
dose. One finds a factor of RBE = 1.1 for protons. 

All treatment plans had to be approved in a last step. Approval parameters are once 
again listed in the corresponding workflow excerpt (appendix C.2.2). The syngo.via 
software creates a treatment plan and a physical beam plan which contains the total 
number and exact energy of all incident protons. 
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4.2.4 Irradiation at HIT 

Approved treatment plans have been enriched prior to irradiation. Laser crosses 
and the imager have been enabled. In the patient treatment room, the PMMA 
phantom was positioned by mapping the laser crosses with the grooves on the 
cylinder surface. The final table position was saved as reference position. Additional 
water tanks had to be placed on the table to ensure sufficient weight (comp. figure 
4.9). 

 

Figure 4.9  Experimental setup of the HIT irradiation 

Note that laser positioning was very precise. Mapping the CT scan with x-ray images 
via attached BeekleyTM spots was not necessary. Although being very dense, FNTDs 
are not well visible on the imaging projection as figure 4.10 shows. 

   

Figure 4.10 Comparison of CT image (left) and imaging projection (right) 

After proton irradiation, only the inserts and the centered FNTD had to be changed. 
Small readjustments of the table had to be done and the next treatment plan could 
be applied. Unfortunately, not all FNTDs have been irradiated at the same day and in 
the same treatment room. Table 4.3 gives an overview of the irradiation procedure: 
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FNTD 
number 

 

 

day of 
irradiation 

 

treatment 
room 

 
 

gk2002 
 

 

April 4th, 2012 
 

H2 
 

gk2003 
 

 

April 22nd, 2012 
 

H1 
 

gk2004 
 

 

April 22nd, 2012 
 

H1 
 

gk2005 
 

 

April 26th, 2012 
 

H2 
 

gk2006 
 

 

April 26th, 2012 
 

H2 
 

gk2007 
 

 

April 26th, 2012 
 

H2 

 
Table 4.3  Irradiation of the PMMA phantom at HIT 

 

4.2.5 Detector readout 

All irradiated detectors were read out with the Zeiss LSM 710 confocal microscope 
using the objective lens 40x / 1.4 Oil DIC II and setting the pinhole diameter to 
43.6 Ɋm (1 AU). In order to reduce acquisition time, the dwell time was set to 
25.21 Ɋs. A detailed readout protocol and overview of all detectors is given in 
appendix B.3. 

 

Figure 4.11 Intensity distribution in gk2002 throughout the entire detector length of 6 mm 
(512 × 512 matrix, 40% relative laser power and 100.09 Ɋm in depth) 
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5 RESULTS 
 

This chapter presents the results of the FNTD irradiation at MPI-K and HIT. In 
section 5.1, high-accuracy ion range measurements are performed for single tracks 
as well as for track bulks. The influence of the pinhole diameter on the range 
precision is investigated and the dose intensity correlation is analyzed over a broad 
range of particle fluences. Section 5.2 covers the evaluation of the in-vivo FNTD 
application. The predicted distal edge is compared to the actual intensity profile in 
the detector. 

 

5.1 High-accuracy ion range measurements 

5.1.1 Single track evaluation 

Single particle tracks are well visible in detectors irradiated with fluences smaller 
than 10଻ cmିଶ. By determining the entrance point into the detector and the end of 
the particle track one can calculate the projected range ܴ. This evaluation technique 
as depicted in figure 5.1 was implemented in the FNTD readout workflow (appendix 
C.1). 

 

Figure 5.1  Measuring the projected range for a single particle track 
 (3.1 × 10଺ carbon ions per cmଶ at 48 MeV) 

Figure 5.1 also shows that the fluorescence signal strongly decreases towards the 
detector edge indicating a low color center density. This means that the entrance 
point is not exactly identifiable. The evaluation routine could, therefore, not be 
automated. 

In order to apply the described evaluation technique, detectors have to be irradiated 
exactly perpendicular to their edge. The entrance angles have been measured for a 
large number of particle tracks and they did not significantly differ from 90°. 
Measuring several hundred single tracks provided results of less than 3% deviation 
from the theoretical SRIM values. 
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FNDT no. 

 

 
particle 

 

number of 
analyzed 

tracks 

 

measured 
range [Ɋm] 

 

SRIM 
range [Ɋm] 

 

deviation 

[%] 
 

 

gk1000 
 

 

C-12 (5+) 
 

430 
 

32.77 ± 0.08 
 

33.05 
 

0.85 ± 0.24 
 

gk1002 
 

 

S-32 (9+) 
 

957 
 

16.55 ± 0.04 
 

16.27 
 

1.72 ± 0.25 
 

gk1003 
 

 

C-12 (5+) 
 

1354 
 

32.59 ± 0.04 
 

33.05 
 

1.39 ± 0.12 
 

gk1009 
 

 

Mg-24 (8+) 
 

225 
 

24.28 ± 0.07 
 

24.01 
 

1.12 ± 0.29 
 

 

jmo2000 
 

 

protons 
 

68 
 

51.24 ± 0.39 
 

49.78 
 

2.93 ± 0.78 
 

jmo2001 
 

 

protons 
 

56 
 

162.9 ± 0.5 
 

160.5 
 

1.50 ± 0.31 
 

rh3 
 

 

Fe-56 
 

36 
 

53.11 ± 0.25 
 

53.56 
 

0.84 ± 0.47 
 

rh6 
 

 

Xe-132 
 

24 
 

49.95 ± 0.34 
 

49.40 
 

1.11 ± 0.69 

 
Table 5.1  Results of the single track evaluation 

FNTDs irradiated with low particles fluences at MPI-K (jmo2000 and jmo2001) as 
well as at the Jyväskylä Accelerator Laboratory in Finland (rh3 and rh6) have been 
evaluated in an internship prior to this thesis. The results are also shown in the table 
above and in its visualization below. 

 

Figure 5.2  Deviations from SRIM values (single track evaluation) 
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5.1.2 Automated bulk evaluation 

FNTDs irradiated with fluences greater than 10଻ cmିଶ can be evaluated much more 
efficiently. Obtained microscope images were cut into small slices of approximately 
40 Ɋm height. The ImageJ plug-in “Stack profile Plot” by Pariksheet Nanda (2012 
[15]) allows saving the gray value profile of such a slice in a .txt file. By determining 
the inflection points of the curve one can calculate the projected range ܴ. This 
routine is illustrated in figure 5.3. Compare appendix C.1 for more details. 

 

Figure 5.3  Measuring the projected range for a track bulk 
 (1.0 × 10ଵଵ magnesium ions per cmଶ at 96 MeV) 

Several hundred slices have been evaluated with this fully automated bulk 
evaluation routine. The results are listed in table 5.2. 

 
FNDT no. 

 

 
particle 

 

number of 
analyzed 

slices 

 

measured 
range [Ɋm] 

 

SRIM 
range [Ɋm] 

 

deviation 

[%] 
 

 

gk1001 
 

 

C-12 (5+) 
 

150 
 

34.03 ± 0.15 
 

33.05 
 

2.97 ± 0.45 
 

gk1004 
 

 

C-12 (5+) 
 

170 
 

33.13 ± 0.06 
 

33.05 
 

0.24 ± 0.18 
 

gk1005 
 

 

C-12 (5+) 
 

170 
 

32.96 ± 0.08 
 

33.05 
 

0.27 ± 0.24 
 

gk1006 
 

 

C-12 (5+) 
 

250 
 

33.64 ± 0.22 
 

33.05 
 

1.79 ± 0.67 
 

gk1007 
 

 

C-12 (5+) 
 

150 
 

35.22 ± 0.09 
 

33.05 
 

6.57 ± 0.27 
 

gk1008 
 

 

S-32 (9+) 
 

100 
 

17.23 ± 0.12 
 

16.27 
 

5.57 ± 0.74 
 

gk1010 
 

 

Mg-24 (8+) 
 

150 
 

25.99 ± 0.07 
 

24.01 
 

8.25 ± 0.29 

 
Table 5.2  Results of the automated bulk evaluation 
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Figure 5.4  Deviations from SRIM values (track bulk evaluation) 

The pinhole diameter seems to be a limiting factor for measurement precision. 
Fluorescent light originating outside of the focal plane washes out the detector edge. 
A comparison of two images only differing in pinhole diameter can be seen in figure 
5.5. 

              

               

 Figure 5.5  Influence of the pinhole diameter: 43.6 Ɋm (left) and 13.5 Ɋm (right) 
 (1.0 × 10ଵଵ magnesium ions per cmଶ at 96 MeV) 
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The influence of the pinhole diameter on range accuracy is quantitatively 
investigated in the following section (5.1.3). The upper left image of figure 5.5 shows 
another interesting effect: At high fluences, nuclear interactions and fragmentation 
lead to the production of fast, light particles. Their tracks can be seen throughout the 
entire detector volume with decreasing density. Because of thin track cores and 
unaltered paths, they could originate from protons and neutrons. A FLUKA 
simulation confirmed this conclusion. Both fluences are 11 orders of magnitude 
smaller than the incident carbon ion fluence. 

 

Figure 5.6  Proton and neutron fluences in a FNTD irradiated with 
  5.0 × 10଼ carbon ions per cmଶ at 48 MeV 

 

5.1.3 Influence of pinhole diameter 

FNTDs irradiated with fluences greater than 10ଽ cmିଶ show washed out detector 
edges when read out with the standard pinhole diameter of 43.6 Ɋm (1 AU). The 
projected range has been re-measured for five different pinhole diameters (43.6, 
33.5, 23.3, 13.5 and 2.9 Ɋm) using automatic bulk evaluation on 50 slices. Optimal 
results are stated in table 5.3. 

 
FNDT no. 

 

 
particle 

 

pinhole 
diameter 

[Ɋm] 

 

measured 
range [Ɋm] 

 

SRIM 
range [Ɋm] 

 

deviation 

[%] 
 

 

gk1001 
 

 

C-12 (5+) 
 

23.3 
 

33.23 ± 0.07 
 

33.05 
 

0.55 ± 0.21 
 

gk1007 
 

 

C-12 (5+) 
 

13.5 
 

32.14 ± 0.11 
 

33.05 
 

2.75 ± 0.33 
 

gk1008 
 

 

S-32 (9+) 
 

13.5 
 

16.31 ± 0.07 
 

16.27 
 

0.27 ± 0.43 
 

gk1010 
 

 

Mg-24 (8+) 
 

13.5 
 

24.53 ± 0.06 
 

24.01 
 

2.18 ± 0.25 

 
Table 5.3  Optimal results of the pinhole variation 
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The reduction of the pinhole diameter can indeed improve range measurement 
accuracy by blocking fluorescent light from outside the focal plane.  For gk1010, the 
deviation dropped from (8.25 ± 0.29)% to (2.18 ± 0.25)%. 

 

5.1.4 Summarized range results 

The Zeiss LSM 710 offers a broad spectrum of readout parameters. For high-
accuracy ion range measurements using FNTDs, one could comply with the 
following readout procedure: 

x Single track evaluation (Ȱ < 10଻ cmିଶ): Choose a high laser power, pixel 
resolution and dwell time to be able to clearly indentify the starting and end 
point of a track. Take multiple images in depth (ȟݖ = 3.05 Ɋm) to ensure 
that track cores lie in the observed focal plane. Measuring approximately 
500 single tracks should lead to results of high agreement with SRIM data. 

x Automatic bulk evaluation (Ȱ > 10଻ cmିଶ): Set the laser power to the 
maximal value but ensure that APDs do not overflow. Regulate the pinhole 
diameter to obtain a sharp detector edge. The dwell time and pixel 
resolution should again be high for a good background signal ratio. Take an 
image along the detector edge in only one depth. The evaluation of 100 slices 
(40 Ɋm height) should yield precise results. 

Following this protocol, the irradiation at MPI-K shows that FNTDs allow for 
measuring ion ranges with very high accuracy. Deviations from SRIM values are 
below the 3% threshold for all analyzed detectors. 

 

Figure 5.7  Correlation between fluence and SRIM value deviation 



 
5.1     High-accuracy ion range measurements 

 

 

35 
 

5.1.5 Dose intensity correlation 

G. J. Sykora et al. investigated the dose response of FNTDs for fast and thermal 
neutrons in 2008 [21]. He comes to the conclusion that the equivalent dose is 
proportional to the particle fluence between 0.1 and approximately 100 mSv. 
Because FNTDs have been irradiated with carbon, magnesium and sulfur ions, an 
intensity dose calibration curve can be established for heavy charged particles. 

 

Figure 5.8  Slice of gk2005 (1.0 × 10଼ carbon ions per cmଶ at 48 MeV) 

To do so, obtained microscope images were cut into small slices of approximately 
40 Ɋm height as depicted in figure 5.8. The program ImageJ allowed measuring the 
maximal intensity in each slice. In order to be able to compare the results, the same 
objective lens and pinhole diameter was used for the detector readout. The intensity 
(or total number of detected photons ܰ), nevertheless, had to be normalized on 
dwell time ߬ and relative laser power ݌ resulting in the adjusted count rate ߟ: 

ߟ  =
ܰ
݌߬  [MHz] 

 

(5.1) 
 

By measuring ߟ for numerous slices and taking the mean of all these values ߟҧ, 
detector impurities can be quantified in the standard deviation ߪ. In order to 
correlate ߟҧ and ܦ, one has to calculate the maximal absorbed dose in the detector 
volume as described in section 2.6. Figure 5.9 shows the resulting depth-dose curves 
based on tabulated SRIM data. 

 

Figure 5.9  SRIM calculated depth-dose curves for 10଻ cmିଶ carbon, magnesium and sulfur ion beams 
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One can now calculate maximal dose values for each irradiated FNTD and match 
them with observed adjusted count rates. Figure 5.10 visualizes table 5.6. 

 
FNDT no. 

 

 
particle 

 

 

total kinetic 
energy [MeV] 

particle 
fluence 
[cmିଶ] 

maximal 
absorbed 
dose [Gy] 

adjusted 
count rate 

[MHz] 
 

 

gk1000 
 

 

C-12 (5+) 
 

48.0 
 

7.7 × 10ହ 
 

7.0 × 10ିଵ 
 

3.58 ± 0.65 
 

gk1001 
 

 

C-12 (5+) 
 

48.0 
 

1.0 × 10ଵଵ 
 

9.1 × 10ସ 
 

122 ± 9 
 

gk1002 
 

 

S-32 (9+) 
 

100 
 

6.7 × 10ହ 
 

1.9 × 10଴ 
 

2.48 ± 0.14 
 

gk1003 
 

 

C-12 (5+) 
 

48.0 
 

3.1 × 10଺ 
 

2.8 × 10଴ 
 

1.98 ± 0.14 
 

gk1004 
 

 

C-12 (5+) 
 

48.0 
 

3.1 × 10଻ 
 

2.8 × 10ଵ 
 

2.53 ± 0.34 
 

gk1005 
 

 

C-12 (5+) 
 

48.0 
 

1.0 × 10଼ 
 

9.1 × 10ଵ 
 

7.42 ± 0.89 
 

gk1006 
 

 

C-12 (5+) 
 

48.0 
 

1.0 × 10ଽ 
 

9.1 × 10ଶ 
 

48.3 ± 7.2 
 

gk1007 
 

 

C-12 (5+) 
 

48.0 
 

1.0 × 10ଵ଴ 
 

9.1 × 10ଷ 
 

98.0 ± 1.6 
 

gk1008 
 

 

S-32 (9+) 
 

100 
 

1.0 × 10ଵଵ 
 

2.9 × 10ହ 
 

88.5 ± 3.0 
 

gk1009 
 

 

Mg-24 (8+) 
 

96.0 
 

4.5 × 10ହ 
 

9.3 × 10ିଵ 
 

1.93 ± 0.54 
 

gk1010 
 

 

Mg-24 (8+) 
 

96.0 
 

1.0 × 10ଵଵ 
 

2.1 × 10ହ 
 

124 ± 5 

 
Table 5.4  Correlation between maximal absorbed dose and adjusted count rate 

 

 

Figure 5.10 Correlation between maximal absorbed dose and adjusted count rate 
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The maximal absorbed dose seems to be proportional to the measured adjusted 
count between 20 and 1000 Gy. In his Diploma thesis (2011 [12]), Florian Lauer 
measured the fluorescent intensity of FNTDs after gamma irradiation. To verify the 
curve seen in figure 5.10, a comparison of both measurements is depicted in figure 
5.11. 

 

Figure 5.11 Comparison of carbon irradiated with gamma irradiated FNTDs 

One can clearly see that the two linear fits mainly differ in their intersection point 
with the ݕ-axis. A possible explanation is the quenching effect: HCPs ionize along 
their trajectories but the detected fluorescence signal is reduced (by a factor of 
approximately 4) due to their high LET. Secondary electrons are not only captured 
in color centers but also recombine with holes in the valence band effectively 
decreasing the density of Fଶା(2Mg) color centers. Another reducing parameter could 
be multiple electron capture resulting in neutral Fଶ(2Mg) color centers which are 
not stimulated by the red 633 nm laser line. 

 

5.2 In-vivo range measurements 

5.2.1 Distal edge comparison 

Appendix B.3 shows the calculated dose distributions within the detector volume. 
Because FNTDs have not been contoured, the treatment planning software 
calculated the distal edge in PMMA and not aluminum oxide. The observed ranges 
should, therefore, be much shorter than the planned ones. But since the 100% and 
10% iso-dose lines always lay within the detector volume, the entire fluorescent 
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spectrum is expected to be observed at the detector edge. The FLUKA simulation 
outlined in section 4.2.1 helps calculating a factor that converts the calculated dose 
distribution in PMMA to an equivalent dose distribution in aluminum oxide. This 
profile can then be compared to the observed fluorescence spectrum. 

Figure 5.12 shows two simulated inverse dose profiles for 10଼ protons with a kinetic 
energy of 60 MeV. The left plot shows the Bragg peak in PMMA at approximately 
2.65 cm depth. The right plot shows the influence on the dose distribution when 
placing FNTDs at 2.30 cm depth (6 mm length). The Bragg peak narrows and shifts 
to a smaller depth value. 

 

Figure 5.12 Comparison of FLUKA simulated depth-dose distributions: 
60 MeV uΤ  protons in PMMA and in aluminum oxide 

The depth in which the dose drops below the 80% threshold is denoted with ଼ݖ଴. 
 ୊୒୘ୈ marks the beginning of the FNTD in depth (here 2.3 cm). Calculation of theݖ
conversion factor ݂ yields: 

 ݂ =
଴(PMMA)଼ݖ െ ୊୒୘ୈݖ
଴(FNTD)଼ݖ െ ୊୒୘ୈݖ

= 2.756 
 

(5.2) 
 

Planned dose distributions can now be adapted: 

(FNTD)ݖ  =
(PMMA)ݖ െ ୊୒୘ୈݖ

݂ +  ୊୒୘ୈݖ
 

(5.3) 
 

Figure 5.13 shows the exemplary conversion of the planned dose distribution in 
gk2002 and a comparison with the observed signal profile in the detector. The 80% 
dose/intensity threshold marks the projected range. Appendix B.3 contains a 
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detailed overview of all HIT irradiated detectors and their corresponding depth-
dose curves. 

  

  

Figure 5.13 Planned depth-dose curve (top left) converted to an equivalent profile 
in aluminum oxide (top right); intensity profile in gk2002 (bottom left) 

compared to the converted dose curve (bottom right) 

 

5.2.2 Summarized range results 

Measured intensity profiles basically follow planned dose distributions in the 
detector volume as depicted in appendix B.3. The dips in the profiles are due to 
microscope vignetting. The differences in expected and monitored range lie well 
below the 1 mm threshold (comp. table 5.5 and figure 5.14). This threshold is 
defined by the CT slice thickness which is a measure for FNTD positioning accuracy. 
Another error influencing factor is the simulated conversion factor which may not 
apply entirely to each the experimental setup. 
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FNDT no. 

 

 
particle 

 

 

planned mean 
dose [Gy] 

converted 
planned range 

[mm] 

 

measured 
range [mm] 

 

difference 

[mm] 
 

gk2002 
 

 

protons 
 

1.00 ± 0.02 
 

1.30 
 

0.93 
 

0.37 
 

gk2003 
 

 

protons 
 

0.99 ± 0.02 
 

0.87 
 

0.54 
 

0.33 
 

gk2004 
 

 

protons 
 

0.97 ± 0.04 
 

1.08 
 

0.39 
 

0.69 
 

gk2005 
 

 

protons 
 

0.98 ± 0.03 
 

0.78 
 

0.61 
 

0.17 
 

gk2006 
 

 

protons 
 

0.97 ± 0.03 
 

0.80 
 

0.60 
 

0.20 
 

gk2007 
 

 

protons 
 

0.97 ± 0.04 
 

1.07 
 

0.65 
 

0.42 

 
Table 5.5  Results of the in-vivo range measurements 

 

 

Figure 5.14 Deviations from treatment planned ranges 
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6 DISCUSSION AND OUTLOOK 
 

In this thesis, high-accuracy ion range measurements were performed for mono-
energetic particle beams using single track as well as track bulk evaluation 
techniques. FNTDs have also been irradiated under clinical conditions in order to 
investigate the basic suitability for clinical in-vivo applications.  The distal edge 
predicted by the treatment plan was compared to the actual intensity profile 
detected. This chapter discusses the findings and suggests further experiments. 

 

6.1 Range measurements based on single track evaluation 

6.1.1 Results of the single track evaluation 

In the single track evaluation routine introduced in section 5.1.1, entrance and end 
point are marked individually for each particle track. Being very time consuming, 
this routine, nevertheless, allows for measuring the projected range (and the lateral 
straggling) with less than 3% deviation of theoretical SRIM values. Table 5.1 shows 
that measured ranges both over- and under-estimate the projected range. A 
systematic dependency on energy or particle type could, therefore, not be found. A 
reason for these statistical residuals could be the low fluorescence intensity at the 
detector edge leading to uncertainties in determining the entrance point into the 
detector. Furthermore, FNTD edges are not cut perfectly straight with fluctuations 
up to 2 Ɋm. Combination of these two circumstances might explain observed 
deviations. 

 

6.1.2 Influence of the nuclear stopping power component 

The spatial resolution of FNTDs cannot be the reason for the residuals found since 
structures on a submicrometer-scale can be resolved. Because radiochromatic 
transformation is believed to be triggered by electronic interactions in the detector, 
the influence of the linear nuclear stopping power component on the projected 
range is analyzed in figure 6.1. Comparison of electronic and nuclear contributions 
to the SRIM calculated depth-dose curve of a 48 MeV carbon ion beam in aluminum 
oxide, nevertheless, show that the latter can be neglected when measuring the 
projected range at the 80% dose threshold. Even at very low particle energies, 
nuclear interactions have little influence on the depth-dose curve. The assumption 
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that they are not being monitored by FNTDs can, therefore, not explain 3% 
deviations from tabulated SRIM values. 

 

Figure 6.1  Electronic and nuclear contributions to the absorbed dose 
(48 MeV carbon ion beam in aluminum oxide) 

Single track evaluation could be applied to detectors irradiated with fluences 
smaller than 10଻ cmିଶ. This corresponds to maximal clinical doses of approximately 
0.1 and 4.2 Gy for 4 MeV uΤ  protons and carbon ions, respectively. 

 

6.2 Range measurements based on automated bulk evaluation 

6.2.1 Results of the track bulk evaluation 

For FNTDs irradiated with more than 10଻ particles per cmଶ, range measurement 
routines could be automated. The fast bulk evaluation technique determines the 
distance between two inflection points in the corresponding intensity profile 
yielding the same level of precision (less than 3% deviation of theoretical SRIM 
data). A limiting factor is the pinhole diameter. Fluorescent light originating outside 
of the focal plane washes out the detector edge. It was shown that the reduction of 
the pinhole diameter can indeed improve range measurement accuracy for high 
particle fluences by blocking fluorescence off focus. 

 

6.2.2 Quenching effect 

In contrast to a simple picture, the observed quenching effect can be separated into 
saturation within a single track core and saturation of the entire detector due to 
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high particle fluences. The comparison of carbon irradiated with gamma irradiated 
FNTDs clearly shows saturation effects within HCP track cores (comp. figure 5.11). 
The detected fluorescent signal is reduced due to a high LET. The adjusted count 
rate, nevertheless, increases linearly with increasing dose up to 1000 Gy (10ଽ 
carbon ions per cmଶ at 48 MeV). This shows that clinical particle fluences will not 
cause additional saturation effects in FNTDs. 

 

6.3 In-vivo range measurements 

6.3.1 Results of the in-vivo range measurements 

In a second series of experiments, FNTDs placed behind various insert combinations 
have been irradiated with protons under clinical conditions. Measured intensity 
profiles agree with planned dose distributions within limiting CT resolution. The 
possible high range measurement accuracy enabled by FNTDs is, nevertheless, 
jeopardized by positioning difficulties due to the CT slice thickness of 1 mm. 
Standard CT scans are even done with a slice thickness of 3 mm which is large 
compared to a FNTD length of 6 mm (~20 mm water equivalent). Another factor 
influencing planned dose distributions is the water equivalent path length (WEPL) 
of used tissue surrogates. If the treatment planning software contains errors 
concerning these values, the true projected range will of course differ from 
calculation. 

Figure 6.2 shows that FNTDs are not only suitable for range measurements but also 
for monitoring entire predicted dose distributions. The planned dose plateau from 3 
to 4 mm depth is reproduced by the fluorescence profile. The intensity peak at the 
end of the detector might originate from transition effects. 

 

Figure 6.2  Comparison of measured intensity profile with converted planned dose distribution 
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6.3.2 WEPL measurements 

The WEPLs of individual PMMA and aluminum oxide slabs have recently been 
measured with 270.55 MeV uΤ  carbon ions (C. Tremmel, pers. comm.): 

 WEPL(ܲܣܯܯ) = 1.154 (6.1) 
 

 WEPL(ܦܶܰܨ) = 3.288 (6.2) 
 

Note that the treatment planning system assumes a PMMA WEPL of 1.165. Based on 
these results, the conversion factor should be slightly larger than the one introduced 
in equation 5.2: 

 ݂ =
WEPL(ܦܶܰܨ)
WEPL(ܲܣܯܯ) =  2.849 > 2.756 

 

(6.3) 
 

Although the experimental setup does not match the in-vivo FNTD irradiation with 
approximately 60 MeV uΤ  protons and one could question the concept of a constant 
WEPL over a broad energy range, the fact that measured ranges are smaller than the 
prediction (comp. table 5.5) allows concluding that the conversion factor ݂ might 
have been slightly under-estimated. 

All FNTDs irradiated within this thesis were aligned parallel to the beam direction in 
order to assure that particle tracks and track bulks are parallel to the focal planes of 
the microscope. This ensures that projected ranges are not being under-estimated. 
But because precisely parallel irradiation cannot always be assured in in-vivo FNTD 
applications, the following further experiments are being suggested. 

 

6.4 Suggestions for further experiments 

6.4.1 In-vivo irradiation under pre-clinical conditions 

Described and analyzed in-vivo irradiations of FNTDs faced a large number of 
uncertainties (e.g. CT imaging resolution, optimization routine, beam quality, broad 
energy spectrum). One could repeat the in-vivo experiments with a mono-energetic 
proton beam breaking down the level of complexity. High range conformity could be 
achieved leading to a very sharp distal edge in the detector volume. This would 
additionally simplify the comparison of the forward calculated treatment plan with 
the detected fluorescence profile. 
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6.4.2 In-vivo irradiation with carbon ions 

At HIT, patients can be treated with protons as well as with carbon ions.  One could, 
therefore, repeat the outlined in-vivo irradiation with a carbon ion beam. Additional 
high resolution CT scans would minimize FNTD positioning uncertainties. A second 
holder could ensure the investigation of tilted irradiated as it would be the case in 
most in-vivo FNTD applications.  

 

6.4.3 Dose calibration curves for protons and carbon ions 

The irradiation of FNTDs over a broad range of fluences has shown that the 
fluorescent signal strength is proportional to the absorbed dose in a HCP dependent 
dose regime. One could, therefore, establish calibrations curves for protons and 
carbon ions by irradiating FNTDs with ion beams of well-known energy and fluence. 
By correlating adjusted count rate and absorbed dose, one could validate calculated 
treatment plans without FNTD positioning constraints. This might open the 
possibility for FNTD applications in quality assurance and irradiation control. 
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A.1 List of abbreviations (in alphabetical order) 

APD  Avalanche photodiode 
CERN  European Organization for Nuclear Research 
CSDA  Continuous slowing down approximation 
CT  Computed tomography 
CTV  Clinical target volume 
DKFZ  German Cancer Research Center 
FLUKA  Fluctuating cascade 
FNTD  Fluorescent nuclear track detector 
HCP  Heavy charged particles 
HIT  Heidelberg Ion-Beam Therapy Center 
ICRU  International Commission on Radiation Units 
  and Measurements 
INFN  National Institute for Nuclear Physics, Italy 
LET  Linear energy transfer 
LSM  Laser scanning microscopy 
MPI-K  Max Planck Institute for Nuclear Physics 
PET  Positron emission tomography 
PMMA  Polymethyl methacrylate 
PMT  Photomultiplier 
RBE  Relative biological effectiveness 
SRIM  Stopping and Range of Ions in Matter 
WEPL  Water equivalent path length 
 
 

A.2 List of symbols (as mentioned in the text) 

AlଶOଷ: C, Mg Aluminum oxide doped with carbon and 
  magnesium 
Ȱ  Particle fluence 
 റ  Point vector in spaceݎ
ܰ  Number of particles 
 Perpendicular area  ୄܣ
߳௜   Deposited energy in a single interaction 
߳௜௡  Kinetic energy of an incident ionizing particle 
߳௢௨௧   Sum of the kinetic energies of all ionizing 

particles leaving the interaction 
ܳ  Change in the rest energies of the nucleus and of  
  all particles involved in the interaction 
߳  Total imparted energy 
݉  Rest mass 
 Absorbed dose  ܦ
 Kinetic energy  ܧ
݈  Traversed distance 
ܵ  Linear stopping power 
ܵ௘௟   Linear electronic stopping power 
ܵ௥௔ௗ   Linear radiative stopping power 
ܵ௡௨௖   Linear nuclear stopping power 
LET௱  Linear energy transfer 
 Specific energy cutoff for secondary electrons  ߂
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௱ఋܧ   Sum of the kinetic energies of all secondary 

electrons greater than ߂ 
ܴ  Projected range and outer cylinder radius 
 ௠௜௡  Minimal kinetic energyܧ
௠௔௫ܧ   Maximal kinetic energy 
ȟܴ௡  Width of voxel ݊ 
 ݊ ௡  Kinetic energy when entering voxelܧ
ܵ௡  Corresponding linear stopping power to ܧ௡ 
 ଴  Initial kinetic energy of the particle beamܧ
 ݊ ௡  Absorbed dose in voxelܦ
 Physical density  ߩ
௠௔௫ܦ   Maximal absorbed dose 
Fଶଶା(2Mg) Two-electron color center 
߬  Lifetime and dwell time 
 ௚  Band gapܧ
 ௭  Effective slice thicknessߜ
݀  Pinhole diameter 
௠௔௫ߟ   Maximal photon counting rate 
݃  Digital gain 
ȟ݃  Digital offset 
݈௫ , ݈௬  Field size 
 Relative excitation laser power  ݌
ȟݖ  Step size in depth 
ܰ௠௔௫   Maximal dynamic range 
 Cylinder length  ܮ
 Inner cylinder radius  ݎ
 ௘  Electron densityߩ
௘௪ߩ   Electron density of water 
 Faraday cup current  ܫ
 Charge of incident particles  ݖ

 Adjusted count rate  ߟ
 ҧ  Mean adjusted count rateߟ
 Standard deviation  ߪ
 ଴  Depth is which the absorbed dose reaches the଼ݖ

80% threshold 
 ୊୒୘ୈ Beginning of FNTD in depthݖ
݂  Conversion factor 

 

A.3 List of figures 

Figure 2.1 CSDA for particles traversing small volumes of 
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Figure 4.4 Schematic diagram of the FNTD irradiation at HIT 
Figure 4.5 FLUKA simulated two dimensional depth-dose 
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A.5 List of experiments 

February 28th, 2012 Irradiation of FNTDs with carbon 
and sulfur ions (detectors gk1000 
– gk1008) at MPI-K 

February 29th, 2012 Irradiation of FNTDs with 
magnesium ions (detectors 
gk1009 and gk1010) at MPI-K 

March 29th, 2012 CT scans of all six insert 
combinations at the Kopfklinik, 
Heidelberg University Hospital on 
Siemens SOMATOM Sensation 4 
CT Scanner 

March 30th, 2012 Contouring and planning at HIT 
(in corporation with Swantje 
Ecker) 

April 4th, 2012 Irradiation of gk2002 with 
protons at HIT (patient room H2) 

April 11th – 13th, 2012 Contouring and planning at HIT 
(in corporation with Swantje 
Ecker) 

April 22nd, 2012 Irradiation of gk2003 and gk2004 
with protons at HIT (patient room 
H1) 

April 26th, 2012 Irradiation of gk2005, gk2006 and 
gk2007 with protons at HIT 
(patient room H2)
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B READOUT PROTOCOLS AND IMAGES 
 

B.1 FNTDs irradiated at MPI-K 

The following images were obtained using the objective lens 40x / 1.4 Oil DIC II and setting the pinhole diameter to 43.6 Ɋm (1 AU). 

 
FNDT no. 

 

 
particle 

 

 

kinetic energy 
[MeV] 

 

fluence 
[1 cmଶΤ ] 

digital gain 
and dwell 
time [Ɋs] 

 

matrix size 

[px and Ɋm] 

 

tile scan size 

[matrices] 

surface, step 
size, range  

[Ɋm], slice no. 

 

laser intensity 
[%] 

 
 

gk1000 
 

 

C-12 
 

48.0 
 

7.7 × 10ହ 0.21, 
50.42 

512 × 512, 
212.1 × 212.1 

 

1 × 3 55.94, 3.05, 
100.65, 34 

 

100 
 

gk1001 
 

 

C-12 
 

48.0 
 

1.0 × 10ଵଵ 0.20, 
50.42 

512 × 512, 
212.1 × 212.1 

 

1 × 18 65.21, 
no stack 

 

15 
 

gk1002 
 

 

S-32 
 

100 
 

6.7 × 10ହ 0.20, 
78.79 

164 × 512, 
112.8 × 353.6 

 

1 × 3 63.02, 3.05, 
100.65, 34 

 

100 
 

gk1003 
 

 

C-12 
 

48.0 
 

3.1 × 10଺ 0.20, 
67.53 

192 × 508, 
119.6 × 317.4 

 

1 × 2 43.60, 3.05, 
100.65, 34 

 

100 
 

gk1004 
 

 

C-12 
 

48.0 
 

3.1 × 10଻ 0.20, 
64.65 

200 × 512, 
82.6 × 212.1 

 

1 × 1 47.05, 3.05, 
100.65, 34 

 

100 
 

gk1005 
 

 

C-12 
 

48.0 
 

1.0 × 10଼ 0.20, 
57.96 

223 × 512, 
92.0 × 211.8 

 

1 × 1 34.56, 3.05, 
100.65, 34 

 

100 
 

gk1006 
 

 

C-12 
 

48.0 
 

1.0 × 10ଽ 0.20, 
50.42 

512 × 512, 
212.1 × 212.1 

 

1 × 18 61.06, 10, 
20, 3 

 

30 
 

gk1007 
 

 

C-12 
 

48.0 
 

1.0 × 10ଵ଴ 0.20, 
50.42 

512 × 512, 
212.1 × 212.1 

 

1 × 18 57.29, 
no stack 

 

20 
 

gk1008 
 

 

S-32 
 

100 
 

1.0 × 10ଵଵ 0.20, 
50.42 

512 × 512, 
212.1 × 212.1 

 

1 × 18 71.17, 
no stack 

 

20 
 

gk1009 
 

 

Mg-24 
 

96.0 
 

4.5 × 10ହ 0.20, 
63.56 

204 × 519, 
84.1 × 214.7 

 

1 × 3 50.47, 3.05, 
100.65, 34 

 

100 
 

gk1010 
 

 

Mg-24 
 

96.0 
 

1.0 × 10ଵଵ 0.20, 
50.42 

512 × 512, 
212.1 × 212.1 

 

1 × 18 77.88, 
no stack 

 

15 
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The following three sets of images were obtained using the objective lens 40x / 1.4 Oil DIC II at five different pinhole diameters (43.6, 
33.5, 23.3, 13.5 and 2.90 Ɋm). 

 
FNDT no. 

 

 
particle 

 

 

kinetic energy 
[MeV] 

 

fluence 
[1 cmଶΤ ] 

digital gain 
and dwell 
time [Ɋs] 

 

matrix size 

[px and Ɋm] 

 

tile scan size 

[matrices] 

surface, step 
size, range  

[Ɋm], slice no. 

 

laser intensity 
[%] 

 
 

gk1001 
 

 

C-12 
 

48.0 
 

1.0 × 10ଵଵ 0.20, 
50.42 

512 × 512, 
212.1 × 212.1 

 

1 × 10 107.31, 
no stack 

 

15 
 

gk1008 
 

 

S-32 
 

100 
 

1.0 × 10ଵଵ 0.20, 
50.42 

512 × 512, 
212.1 × 212.1 

 

1 × 10 178.16, 
no stack 

 

20 
 

gk1010 
 

 

Mg-24 
 

96.0 
 

1.0 × 10ଵଵ 0.20, 
50.42 

512 × 512, 
212.1 × 212.1 

 

1 × 10 109.82, 
no stack 

 

15 

 

 

The following set of images was obtained using the objective lens 40x / 1.4 Oil DIC II at a pinhole diameter of 13.5 Ɋm (0.31 AU) and five 
different relative laser powers (25, 40, 60, 80 and 100%). 

 
FNDT no. 

 

 
particle 

 

 

kinetic energy 
[MeV] 

 

fluence 
[1 cmଶΤ ] 

digital gain 
and dwell 
time [Ɋs] 

 

matrix size 

[px and Ɋm] 

 

tile scan size 

[matrices] 

surface, step 
size, range  

[Ɋm], slice no. 

 

laser intensity 
[%] 

 
 

gk1010 
 

 

Mg-24 
 

96.0 
 

1.0 × 10ଵଵ 0.20, 
50.42, 1 

512 × 512, 
212.1 × 212.1 

 

--- 109.82, 
no stack 

25, 40, 
60, 80, 100 

 

 

The following images for overview purposes were obtained using the objective lens 40x / 1.4 Oil DIC II at a dwell time of 100.85 Ɋs: 
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Overview I:      FNTDs irradiated with 48.0 MeV carbon ions 

first row (from left to right): gk1000 (7.7 × 10ହ cmିଶ, 100%), 
gk1003 (3.1 × 10଺ cmିଶ, 100%), 
gk1004 (3.1 × 10଻ cmିଶ, 100%) 

second row (from left to right): gk1005 (1.0 × 10଼ cmିଶ, 100%), 
gk1006 (1.0 × 10ଽ cmିଶ, 50%), 
gk1007 (1.0 × 10ଵ଴ cmିଶ, 30%) 

third row (from left to right): gk1001 (1.0 × 10ଵଵ cmିଶ, 20%) 
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Corresponding intensity profiles for FNTDs irradiated with carbon ions: 
adjusted count rate [MHZ] plotted against detector depth [Ɋm] 
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Corresponding 
intensity profiles for 

FNTDs irradiated with 
sulfur ions: 

adjusted count rate 
[MHZ] plotted against 
detector depth [Ɋm] 

 

Overview II:      FNTDs irradiated with 
100 MeV sulfur ions 

left:  gk1002 (6.7 × 10ହ cmିଶ, 100%) 
right:  gk1008 (1.0 × 10ଵଵ cmିଶ, 20%) 
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Corresponding 
intensity profiles for 

FNTDs irradiated with 
magnesium ions: 

adjusted count rate 
[MHZ] plotted against 
detector depth [Ɋm] 

 

Overview III:      FNTDs irradiated with 
96.0 MeV magnesium ions 

left:  gk1009 (4.5 × 10ହ cmିଶ, 100%) 
right:  gk1010 (1.0 × 10ଵଵ cmିଶ, 30%) 
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B.2 CT images of the PMMA phantom 

Obtained DICOM (Digital Imaging and Communications in Medicine) data were visualized with the open-source software MITK-3M3 
(version 1.1) developed by the division of Medical and Biological Informatics at DKFZ and mint medical. The intersection of the blue and 
red line marks the position of the FNTDs. In all following images, protons would enter the PMMA cylinder from the left. 

 

   

 

 

 

 

 

 
gk2002: 

2.8 cm PMMA in front of the FNTD holder 

 
gk2003: 

16.8 cm PMMA in front of the FNTD holder 
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gk2004: 

5.6 cm PMMA, 1.0 
cm titanium and 
5.6 cm PMMA in 

front of the FNTD 
holder 

 
 

gk2005: 

11.2 cm PMMA 
and 5.6 cm LN-450 
lung in front of the 

FNTD holder 

 
 

gk2006: 

5.6 cm LN-450 
lung and 5.6 cm 

PMMA in front of 
the FNTD holder 

 
 

gk2007: 

5.6 cm AP6 
adipose, 5.6 cm 

LV1 liver and 5.6 
cm CB2-30% bone 

in front of the 
FNTD holder 
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B.3 FNTDs irradiated at HIT 

The following images were obtained using the objective lens 40x / 1.4 Oil DIC II and setting the pinhole diameter to 43.6 Ɋm (1 AU). They 
show the intensity distribution throughout the entire detector length of 6 mm at a depth of approximately 100 Ɋm. 

 
FNDT no. 

 

 
particle 

 

prescribed 
mean dose 

[Gy] 

digital gain 
and dwell 
time [Ɋs] 

 

matrix size 

[px and Ɋm] 

 

tile scan size 

[matrices] 

surface, step 
size, range  

[Ɋm], slice no. 

 

laser intensity 
[%] 

 

gk2002 
 

 

protons 
 

1.00 ± 0.02 0.20, 
25.21 

512 × 512, 
212.1 × 212.1 

 

6 × 29 100.09, 
no stack 

 

40 
 

gk2002 
 

 

protons 
 

0.99 ± 0.02 0.20, 
25.21 

512 × 512, 
212.1 × 212.1 

 

6 × 29 100.09, 
no stack 

 

60 
 

gk2002 
 

 

protons 
 

0.97 ± 0.04 0.20, 
25.21 

512 × 512, 
212.1 × 212.1 

 

6 × 29 100.09, 
no stack 

 

60 
 

gk2002 
 

 

protons 
 

0.98 ± 0.03 0.20, 
25.21 

512 × 512, 
212.1 × 212.1 

 

6 × 29 100.09, 
no stack 

 

60 
 

gk2002 
 

 

protons 
 

0.97 ± 0.03 0.20, 
25.21 

512 × 512, 
212.1 × 212.1 

 

6 × 29 100.09, 
no stack 

 

60 
 

gk2002 
 

 

protons 
 

0.97 ± 0.04 0.20, 
25.21 

512 × 512, 
212.1 × 212.1 

 

6 × 29 100.09, 
no stack 

 

60 
 

The intensity profiles are being compared to the optimized dose distributions calculated with the syngo.via software. By applying the 
conversion factor ݂, PMMA calculated distal edges have been transformed to aluminum oxide equivalent curves. Because of the CT slice 
thickness, there only is one data point each converted mm. 
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gk2002: 

top: 2.8 cm PMMA in front of 
the FNTD (40% laser 

intensity) 

bottom left: planned dose 
distribution with FNTD in 

black rectangle 

bottom right: comparison of 
measured intensity profile 

with converted planned dose 
distribution 
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gk2003: 

top: 16.8 cm PMMA in front of 
the FNTD (60% laser 

intensity) 

bottom left: planned dose 
distribution with FNTD in 

black rectangle 

bottom right: comparison of 
measured intensity profile 

with converted planned dose 
distribution 
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gk2004: 

top: 5.6 cm PMMA, 1.0cm 
titanium and 5.6 cm PMMA in 
front of the FNTD (60% laser 

intensity) 

bottom left: planned dose 
distribution with FNTD in 

black rectangle 

bottom right: comparison of 
measured intensity profile 

with converted planned dose 
distribution 
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gk2005: 

top: 11.2 cm PMMA and 5.6 
cm LN-450 lung in front of the 

FNTD (60% laser intensity) 

bottom left: planned dose 
distribution with FNTD in 

black rectangle 

bottom right: comparison of 
measured intensity profile 

with converted planned dose 
distribution 
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gk2006: 

top: 5.6 cm LN-450 lung and 
11.2 cm PMMA in front of the 
FNTD (60% laser intensity) 

bottom left: planned dose 
distribution with FNTD in 

black rectangle 

bottom right: comparison of 
measured intensity profile 

with converted planned dose 
distribution 
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gk2007: 

top: 5.6 cm AP6 adipose, 5.6 
cm LV1 liver and 5.6 cm CB2-

30% bone in front of the 
FNTD (60% laser intensity) 

bottom left: planned dose 
distribution with FNTD in 

black rectangle 

bottom right: comparison of 
measured intensity profile 

with converted planned dose 
distribution 
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C WORKFLOW EXCERPTS 
 

C.1 FNTD range measurements in ImageJ

1.   Load image in ImageJ. 

2.   Scale is automatically set when you open .lsm files. 

3.   Label slices of the z-stack to get a better overview. 

ż Image -> Stacks -> Label 
·   Format = 0 
ͼ���^ƚĂƌƚŝŶŐ�ǀĂůƵĞ�с�ȴǌFirst of the z-stack 
ͼ���/ŶƚĞƌǀĂů�с�ȴǌ�ŽĨ�ƚŚĞ�ǌ-stack 
·   Text = FNTD number: particle, energy, 

fluence 
·   Select Use text tool font, so the text is 

written the way you chose it before and is 
the same for all z-stacks you work with. 

·   Select Preview to adjust font size and 
arrange text location. 

 
4.   To get a better contrast select another color and adjust the 

brightness. Play around with these setting to clearly see the 
edge of the detector. 

ż  Image -> Lookup tables -> Green Fire Blue 
(optional) 

ż  Image -> Adjust -> Brightness/Contrast 
 

5.   Since you can see the same track on multiple slices of the z-
stack, choose that slice for range measurement, where the 
track is most exact. 

6.   In order to measure the range (horizontal length of the 
track) of a specific track, follow the following steps. 

ż  Use the Straight Line Selection Tool from the 
Toolbar 

·     Hold the shift-key during drawing the line, 
because the shift-key forces the line to be 
horizontal. 

·     Analyze -> Measure (Ctrl + M) will show 
you the results (length, ...) 

·     Analyze -> Label will make your selected 
line permanent + labels it with a number 

 alternative method: 

ż  Use the Multi-Point Tool from the Toolbar 
·     Select the starting point of the track. 
·     Select the end point of the track. 
·     Analyze -> Measure (Ctrl + M) will show 

you the x and y positions of the two 
points. Label the track (Analyze -> Label). 
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ͼ�����dŚĞ�ĚŝĨĨĞƌĞŶĐĞ�ȴǆ�ŝƐ�ƚŚĞ�ƌĂŶŐĞ�ŽĨ�ƚŚĞ�
particle. 

7.   In order to measure the range (horizontal length) of 
      a  bulk of tracks by hand (fluences > 1e7 1/cm²), 
      follow the following steps. 

ż     Image setup: 
·     Straighten your image by setting the line 

width (Edit -> Options -> Line Width) to 
approximately 150% of the expected 
range and selecting the center of the bulk 
on top and bottom of your image. Edit -> 
Selection -> Straighten will now generate 
a modified image. This tool also works for 
stacks when editing the first image. 

·     Image -> Transform -> Rotate 90 Degrees 
Right will restore the original image/stack 
orientation. 

·     If you are working with a stack you will 
now have to montage it: Image -> Stacks 
-> Make Montage. (Columns = 1, Rows = 
no. of images in stack, Scale Factor =1).  

·     Image -> Stacks -> Tools -> Montage to 
Stack will cut up your montage in a 
desired number of pieces and arrange 
them in a new stack. 

·     There are now two different methods 
allowing the measurement of the bulk 
range. 

ż  Use the Rectangle Tool from the Toolbar: 

·     Analyze -> Measurements... Check 
“Bounding rectangle” 

·     Select an area in which the starting and 
end point of numerous tracks are 
identifiable. 

·     Analyze -> Measure (Ctrl + M) will show 
you the width (and hight) of the drawn 
rectangle in pixels. 

·     Repeat this routine for all images in your 
stack. 

ż  Use Plot Profile from the Toolbar: 
·     Select all (Ctrl + A) 
·     Analyze -> Plot Profile (Ctrl + K) 
·     Select the rise and fall of the gray value 

using the multi-point tool. 
·     Measure the x positions (in pixels) of your 

two selected points (Ctrl + M). 
·     Repeat this routine for all images in your 

stack. 
 

8.   The bulk range measurement for fluences > 1e7 1/cm²  
can also be performed automatically for high resolution 
images with a sharp detector edge: 

ż  Setup your image following the instructions  under 
7. 

ż  Add Stack profile Plot macro (by Pariksheet Nanda) 
to your StartupMacros.txt file under /Program 
Files/ ImageJ/macros: 
         ·     Select all (Ctrl + A) of your montaged stack. 
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               ·     Run the Stack profile Plot macro. 
               ·     The text file containing gray value  
    information of all images in your stack 

will be saved to your desktop. 

ż     Evaluation in R: 
·     Find the maximal and minimal slope of 

each profile. The difference of these 
positions is the projected range in pixel 
units. 

9.   In order to measure the real length of a specific track, 
       follow the following steps. 

ż  Use the Segmented Line Selection Tool from the 
Toolbar 

·     Create a segmented line selection by 
repeatedly clicking with the mouse on 
the track. Each click will define a new line 
segment. Double click when finished. 

·     Analyze -> Measure will show you the 
results (length,..) 

·     Analyze -> Label will make your selected 
line permanent + labels it with a number 

10.   Optionally: 

ż Maybe it is helpful to draw a vertical line, where 
the edge of the FNTD is expected to be. It might be 
helpful to better see the starting point of the track 
during the actual range measurement. 

 

C.2 Treatment planning at HIT 

C.2.1 Contouring on Siemens patient system 

Ɣ save the obtained CT data to 
\\10.7.72.26\transfer\data\TPS-FileSharing\MyFolder 

Ɣ using one of the treatment planning computers copy all CT 
images  to C:\TEMP\MyFolder 

Ɣ data import (set switch on VC): 
ż open the patient browser with “, Entf” on the 

keyboard 
ż transfer -> import from off-line... -> select all CT 

images of the corresponding scan 
ż a new patient will open under local database 

ż drag the imported files onto the contouring 
window (see screenshot 1) 

Ɣ contouring: 
ż add new structure 

Ŷfor PMMA select normal organ as type, PMMA 
as physical material and <not assigned> as 
biological material (color can also be 
adjusted) 

Ŷfor surrounding skin (area where dose will be 
calculated in the treatment plan) select 
external as type, <not assigned> as physical 
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material and chordoma2 as biological 
material 

Ŷfor target volume select CTV as type, <not 
assigned> as physical and biological 
material 
 

 

screenshot 1: patient browser 

 
ż edit existing structures in segmentation mode 

Ŷuse the ellipse or rectangle tool under the 
contour menu (switch between the two 
with right mouse click) 

Ŷthe ruler helps measuring the dimensions of 
your structure 

Ŷstructures can be expanded to the 
previous/next slice by clicking on the 
corresponding button in the contour menu 

Ŷdouble click on an image will enlarge/close it 
Ŷthe view menu offers zooming and rotation 

possibilities 
ż setting laser origin and ZP (Zielpunkt) in reference 

manager 
Ŷattention: the ZP can only be set once! 

ż the result should look similar to screenshot 2 
(depending on your geometry); 
target in red, skin in gray and PMMA in both light 
blue and orange: 

 

screenshot 2: Siemens patient system (contouring) 
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Ɣ save screenshots (“Drucken” on keyboard) as .png files 
using paint 

Ɣ close patient with the bottom right button 
Ɣ press “, Entf” on the keyboard to open the patient browser 

again 
Ɣ send files to the HIT archive: 

ż transfer -> send to -> HIT_ARCHIV 
ż if your patient already exists in the archive simply 

sync and release lock 

IMPORTANT: Always select the complete folder when 
sending files to the HIT archive; 

check whether all files have been transferred 
 

sync and release lock:  transfer status:  
 

Ɣ switch to TPC in order to set up a treatment plan under 

C.2.2 Treatment planning under Tx 

Ɣ start the syngo.via software and enter a valid user name 
and password 

 

 

screenshot 3: syngo.via startup window 

 

Ɣ select “HIT_ARCHIV” as data source and search the patient 
you want to create a treatment plan for with the goggles 
button on the right 

 

 

 

Ɣ select the CT, RTSTRUCT-file and import it to the 
local database pressing:  

 the bag (top right) will show you the importing process 
Ɣ switch data source back to “Local” and re-search your 

patient by clicking on the goggles 
Ɣ before you can open the CT, RTSTRUCT-file you always have 

to assign a workflow template: 
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ż right click on CT, RTSTRUCT-file -> (re-)assign 
workflow template... -> Tx planning (see screenshot 
3) 

Ɣ a double click on the CT, RTSTRUCT-file to open 
 

 
screenshot 4: define Tx plan 

Ɣ define Tx plan: 
ż to create a new Tx plan click on:  
ż enter a plan name; plan type: patient 

treatment; CT image set: BPL native 1.0 H40s; 
radiation type: particle; plan description: optional 

ż click on accept 
ż four submenus will open: prescription, beam setup, 

pos. verification and patch plan 
ż PRESCRIPTION: 

Ŷnumber of fractions (Fx): 10 (in order to have 
the possibility of more than one radiation 
with the same treatment plan) 

Ŷdose type: effective in Gy 
Ŷprescription description: “10 x 1 Gy phys. 

Protonen” (depending on your desired 
particle type and dose) 

Ŷselect the contoured target with prescription 
set to “MEDIAN” 

Ŷdelete the max. dose und 
additional information 
 

 

screenshot 5: prescription 

 

 

screenshot 6: beam setup 
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ż BEAM SETUP: 
Ŷcreate a new Tx beam by 

clicking on: 
Ŷname: 01T270; particle type: protons; fixed BL: 

90°, table: 270° 
Ŷtreatment room: Room1 
Ŷpatient support: room1table 
Ŷassign ZP (Zielpunkt) as reference 

point in submenu; all positioning 
coordinates should switch to 0.00 

Ŷlateral beam spot density: FWHM (8.0 mm) and 
grid size (3.0 mm); fixed settings for 
protons which should not be changed for 
optimization 

Ŷlongitudinal beam spot density: ripple filter 
(none), Bragg peak width (0.0 mm) and 
range step (2.0 mm) (ignore warning 
message); The range step determines the 
energy settings. For protons a min. value 
of 1.0 mm is possible. The smaller the range 
step, the longer the total radiation time. 

Ŷweight: 1.00 (because there only is one beam) 
Ŷtolerance table: Tt1 

 

 

screenshot 7: position verification 

 
 

ż POSITION VERIFICATION: 
Ŷcheck both PV0 and 01T270_PV in order to 

active x-ray positioning 
ŶTx Room: Room1 
Ŷtolerance table: Tt1 
Ŷorgan program: AXKopf_H1 
Ŷpositioning parameters (lat_iec, long_iec, 

vert_iec) should automatically be set to 
0.00 

ż PATCH PLANE: no further settings necessary 
 

Ɣ The Tx plan is now defined. Open the optimization menu: 
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Ɣ You will once again find four subtopics: dose constraints, 
beam weights, algorithm parameters and basic data set. 
The following settings are advised for a standard proton 
radiation plan. 

ż DOSE CONSTRAINTS: 
Ŷselect “proton absorbed compound algorithm” 

as optimization technique 

 

Ŷmin. target dose: 10 Gy (weight 1.00) 
Ŷmax. target dose: 10 Gy (weight: 2.00) 
Ŷcomment: Min. and max. dose are given for all 

fractions in total. The upper weight ratio 
states that the dose should rather be 
underestimated than overestimated. 

ż BEAM WEIGHTS: set to 1.00 because we created 
one beam 

 

 

screenshot 8: algorithm parameters 

ż ALGORITHM PARAMETERS: 
Ŷdose grid resolution: 2.0 mm (intermediate) x 

2.0 mm (final) 
Ŷcheck double-Gaussian beam model for both 

intermediate and final 
Ŷcheck scattering simulation for both 

intermediate and final 
Ŷlateral cutoff in sigma:: 3.5 (intermediate) x 3.5 

(final) 
Ŷconstant RBE factor: 1.1 
Ŷnumber of iterations: appr. 50 
Ŷobjective function goal: 0.001 
Ŷoptimization strategy: SingleBeamOptimization 
Ŷminimum ion count: 500000 
Ŷregularization weight: 0 
Ŷun-check constr. weight normalization 
Ŷvirtual target expansion: 3.0 mm (lateral) x 0.0 

mm (proximal) x 2.0 mm (distal) 
Ŷcomment: The virtual target expansion gives 

additional degrees of freedom to the 
optimization routine. A broad virtual target 
allows scan spots outside the target 
volume. In order to improve the distal edge 
one can change the distal expansion to 1.0 
mm 
 

Ɣ You can now optimize your treatment plan: 
  

Ɣ If you are working with FNTDs and you want the protons to 
stop in the detector volume, we advise to have the 10% 
dose line at the end of the detector.  
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Ɣ The true absorbed dose will be optimized although the 
radiation can only be applied for calculated effective dose 
distributions. Therefore, a finalization under “proton 
effective compound algorithm” is necessary.  Now, the 
dose distribution for the complete skin will be calculated 
which might significantly differ from the optimized 
absorbed dose distribution. The maximal dose changes to 
RBE * 10 Gy = 11 Gy. 

Ɣ Start the finalization process with: 
Ɣ Close the patient and save your results with:  

 
 
 
 

Ɣ An additional sync with the HIT archive is not required. 
Ɣ If you have successfully created a Tx plan you finally need 

to approve it. (Re-)assign Tx approval as workflow 
template. You will be informed that all intermediate results 
will be discarded. Click on yes and continue the approval 
process: 

ż FX SEQUENCE: 
Ŷcreate new Fx (name: 01Fx.PatientName with 1 

fraction per day) 
Ŷhighlight the plan and add it to Fx 

 

create new Fx:  

add plan to Fx:   

ż continue with REPORT APPROVE: 
 

 

Ŷreport: report_minimal 
Ŷselect the following content: patient 

information, Fx sequence information, MPR 
images, DVH of VOI (both VOI used in 
optimization and add all other VOI); 
attention: always wait for software to 
attach the desired information! 

Ŷtoggle relative 3D distribution: 

Ŷcolor iso-dose areas:  
Ŷmanually set dose to 10.0 Gy and select 5 iso-

dose lines: (10%, 50%, 70%, 90%, 107%) 
Ŷimage set: BPL nativ 1.0 H40s 
Ŷadd additional images (optional) 

ż create report and approve (password required) and 
save the pdf-file 

ż send to treatment 
ż archive results 
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 screenshot 9: report approve 
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